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Introduction

Overview
InfoRad is the premier provider of instant information solutions since 1984. InfoRad presents InfoRad®

Watch-IT™, a text messaging solution that turns your wireless receiver (alpha-numeric pagers, wireless 
PDA’s, and PCS phones with short messaging capability) into a monitoring device for critical applications.

There are three separate versions of Watch-IT available:

Watch-IT ASCII, which provides automated dispatch of wireless messages by monitoring a file directory 
for ASCII text messaging files.

Watch-IT ASCII SV, which provides the same features as Watch-IT ASCII, but has been optimized to run 
as a Windows Service on Windows® 2000 and greater).

Watch-IT Serial, which provides automated dispatch of wireless messages by monitoring a serial port 
information stream.

This user’s guide covers all of these products, since they are similar in operation, with differences in setup 
and configuration. Please refer to the appropriate sections for the version of Watch-IT you have purchased.

Note: If you are using Watch-IT ASCII SV, please note that there are important user interface and 
functionality differences, which are covered in “Watch-IT ASCII SV General Operation” on page 76.

Other Products
Free 30 day Trial versions are available for download for most products at www.inforad.com/demos

Contact InfoRad Sales for more information or to purchase:

Phone: 800-228-8998

E-mail: sales@inforad.com

Products may be also purchased on-line at www.inforad.com/products
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InfoRad Wireless Office InfoRad’s most popular Messaging Software. Internet and dial-up (TAP) 
messaging., basic (One-Time) Message Scheduling, Pre-defined messages, 
Groups, message logging.

InfoRad eText™ Low cost alternative of Wireless Office for basic messaging capability.
InfoRad eText™ supports Internet messaging only. 

InfoRad Wireless Pro Wireless Office features with expanded Groups (500 Receivers per Group), 
expanded Pre-defined Messages (500), expanded Scheduled Messages (500), 
and NEW Advanced Scheduler (recurring scheduled messages - daily, weekly, 
monthly), and  NEW Spell Checker .

AlphaPage® 

First Responder

Includes all Wireless Pro features including NEW Advanced Scheduler and 
NEW Spell Checker plus NEW Route on Failure – automatic rollover to 
secondary receiver address on primary error, NEW Message Templates (pre-
programmed ‘fill in the blank’ type messages), and Direct Serial Connection 
messaging option for use with on-site paging systems or leased-line 
connections.

Watch-IT ASCII™ Turns your wireless receiver into a monitoring device for critical applications 
that produce ASCII text files. (Integrates with CAD Systems, and 
dispatch/service software applications like Bottom Line Software and  
Wintac™.

Watch-IT ASCII SV™ Watch-IT ASCII that runs as a Service on Windows® 2000 and greater. 

Watch-IT ASCII-75™ Low cost, reduced capabilty Watch-IT ASCII for small shops such as  HVAC, 
plumbing, electrical, mechanical, couriers, and taxi services. See Watch-IT 
ASCII for full-featured product.

Watch-IT Serial™ Allows automated dispatch of wireless messages from any computer system 
platform by monitoring a serial port information stream.

Monitor-IT™ Monitors the integrity of a wireless messaging system, reporting system failure 
via a secondary wireless system or e-mail.

Serve-IT™ Customizable application that allows for integrating wireless messaging into an 
existing customer service environment.

InfoRad Enterprise™ A Client/Server solution for sharing the InfoRad Wireless messaging system 
over a LAN or WAN. Wireless Pro and AlphaPage® First Responder features 
including Internet and dial-up (TAP) messaging, NEW Advanced Scheduler, 
NEW Spell Checker, NEW Message Templates, NEW Route on Failure 
features, and Direct Serial Connection messaging option for use with on-site 
paging systems or leased-line connections.

InfoRad Enterprise SV™ InfoRad Enterprise with the Messaging Server runs as a Service on Windows®
2000 and greater.

InfoRad Enterprise iNet™ Low cost, reduced capabilty Enterprise. Available in 2 and 3 Concurrent Client 
license only. Enterprise iNet supports Internet messaging only. Includes NEW 
Spell Checker and NEW Advanced Scheduler features. For full-featured 
product see InfoRad Enterprise and InfoRad Enterprise SV.
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Support
Technical Support is only available to registered users of the software as detailed in the licensing 
agreement. Please register if you haven’t already.

This program is licensed with 90-days free telephone technical support included. AlphaCare Subscription 
options are available that extend the support period, as well as offer priority telephone support and Upgrade 
Protection. Out-of-warranty support is also available on a per-incident basis..

Please call InfoRad Sales at (800) 228-8998 for details on AlphaCare, or e-mail to sales@inforad.com, or 
see our website at www.inforad.com.

InfoRad Software Technical Support is available Monday through Friday 8:30–5:30 ET.

A technical support section with solutions to common problems is also available at 
www.inforad.com/techsupport

Phone: (216) 531-1369

E-mail: techsupport@inforad.com

Internet: www.inforad.com
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InfoRad Watch-IT System Requirements
Watch-IT™
Watch-IT ASCII and Watch-IT Serial are designed to 
operate on computers equipped with at least 4 megabytes of 
hard disk space available, running Windows® 2000 and 
greater. Dial-up (TAP) messaging requires computers 
equipped with a Hayes-compatible modem.

Watch-IT ASCII SV is designed to operate exclusively on 
Windows® 2000 and greater. The computer running the 
Watch-IT ASCII SV Service module must be equipped 
with a Hayes-compatible modem or Internet connection.
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Watch-IT Features
 InfoRad Watch-IT is easy to install and provides fast, intuitive entry and dispatch of your text 

messages. Robust, highly refined.

 Message by Name, Group or Wireless Receiver phone or ID number easily through any 
Messaging Service that accepts remote alphanumeric/text messaging.

 Take advantage of sending messages while performing other tasks on your computer.

 Drop down selections and alphabetical search functions assist you with setup, directory features, 
and sending your messages.

 Message from home, office, or on the road by using Windows dialing options. You can even use 
your phone credit card.

 Message entry includes use of cut and paste functions, recall of previous messages, pre-
programmed messages, and an optional Auto-Split feature for long messages - up to 1024 
characters.

 Schedule messages to be sent at a specific date and time. Use messages as reminders for meetings, 
recurring events, and more.

 Directories can be listed by wireless receiver phone or ID #, Name, Group, and Wireless 
Messaging Service. Your listing also includes message and packet counts.

 Message logging with time/date stamp. Logs can be sorted by recipient or message count.

 Communications options offer you maximum setup flexibility and full compatibility with 
practically any modem.

 Experienced live technical support available.

 Long block/message chaining capable.

 PCS phone short messaging services (SMS).

 Send messages over the Internet (via modem or network connection) directly to your Messaging 
Services Internet Server via Internet messaging protocols WCTP & SNPP.  Messaging via Internet 
E-mail (SMTP) also supported.

 Receive message responses to your e-mail address, or your wireless receivers e-mail address, from 
2-way devices with WCTP and SMTP services.  

 Send messages to on-site/customer-owned paging system or via leased-line connection to 
Messaging Service with Direct Serial Connection Option.

 Expanded Group Members, Scheduled and Predefined Messages 

 HTTP Proxy Authentication support for WCTP Services.

 SMTP Authentication & SSL Connection support for E-mail messaging.

 WCTP Authentication & SSL Connection support.

 NEW Advanced Scheduler – schedule recurring daily, weekly, monthly messages/reminders. 

 NEW Spell Checker – check and correct messages before sending. 

 NEW Message Templates – preformatted, fill-in-the-blank messages.

 NEW Route on Failure – alternate delivery destination / alternate receiver delivery on primary 
failure.

 Extended AlphaCare™ Support Services available: Priority Technical Support, FREE updates. 
Keep your product current with changing Operating System and Wireless specifications.
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Watch-IT Versions
There are four versions of Watch-IT available:

Watch-IT ASCII-75:  A limited version of Watch-IT ASCII: Limits 75 Receivers in the messaging 
directory/database. No ‘Manual Messaging’ capabilities in Message files. (See “Manual Messaging in 
Message Files” on page 68 for more information.)

Watch-IT ASCII: Provides automated dispatch of wireless messages by monitoring a file directory for 
ASCII text messaging files. Unlimited number of Receivers in the messaging directory/database. Also 
permits ‘Manual Messaging’ in message files, allowing messaging information to be provided from outside 
of the Watch-IT ASCII application. (See “Manual Messaging in Message Files” on page 68 for more 
information.)

Watch-IT ASCII SV: Provides the same features as Watch-IT ASCII, but has been optimized to run as a 
Windows Service under Windows® 2000 and greater.

Watch-IT Serial: Provides automated dispatch of wireless messages by monitoring a serial port 
information stream.

For details on upgrading or purchasing other Watch-IT and InfoRad products, please refer to “Watch-IT 
ASCII Versions”  and “InfoRad Wireless Enterprise Upgrade” on page 123.

Important Terms Used in this Manual
The following terms are used throughout the Watch-IT user’s manual:

Network Drive: A logical or mapped drive or UNC path that is located on your network.

Program Drive: The location where the Watch-IT program and data files are stored. This drive is a 
local drive.

Message Drive: The location where the Watch-IT message files used during the sending and 
processing of pages will be stored. This drive is usually a network drive, but can be a local drive.

*Note: If the message drive for Watch-IT ASCII SV is located on a network drive, the Watch-IT 
ASCII SV Service Logon must use a logon that has network rights as well as Administrative rights 
on the Service computer. (Services Control Panel – Logon properties.) 

Messaging Server: The computer which processes and sends the message files. This is the computer 
where the Watch-IT application was installed.

Requirements:

1. Read / Write access to both the program and message drives.

2. Messaging Service connection via one of the following:  dial-out modem, leased-line modem, 
dial-up ISP or network Internet connection. Also, a direct serial connection is supported for 
customer-owned / on-site paging system).

Note: Please see “Access Rights and Watch-IT” on page 9 for information on the specific directory and file 
rights required for proper operation of Watch-IT ASCII.
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What You Need to Get Started
How does a text message get from your computer to your wireless receiver? Unlike sending a numeric 
message, sending a text message is a three-step process:

1. Messaging via the following options:

a.  Dial-up TAP service: InfoRad Watch-IT uses your computer's modem to dial into the Wireless 
Messaging Service's modem Phone Number. This number is different from your Wireless 
Receiver number. If you don't have a Service Phone Number, contact your wireless messaging or 
short messaging service.

b.  Internet service WCTP & SNPP: InfoRad Watch-IT uses your Intenet connection (Dial-up ISP, 
broadband, or network) and connects to the service’s Internet Server for WCTP & SNPP services. 
If you don’t have the Internet address for the WCTP or SNPP service, contact your wireless 
messaging or short messaging service.

c. Internet E-mail (SMTP): InfoRad Watch-IT uses your Internet connection (Dial-up ISP, 
broadband, or network) to connect to your ISP or network e-mail server. If you do not have your 
e-mail server address, contact your ISP or network administrator. 

d. Direct Connection: 

I. InfoRad Watch-IT uses your computer’s serial port and a leased-line modem to connect to 
your Wireless Messaging Service or on-site paging system.

II. InfoRad Watch-IT uses your computer’s serial port and a serial cable connection to connect 
to your on-site paging system.

2. After a connection is made to your wireless messaging service, InfoRad Watch-IT uploads the wireless 
receiver ID number and the message you wish to send.

3. After InfoRad Watch-IT disconnects, your wireless messaging service broadcasts the message through 
their radio tower and out to your wireless receiver.

For every wireless receiver you wish to set up in InfoRad Wireless Watch-IT, you will need the 
following information:

1. The Wireless Receiver Number. If your wireless messaging service uses PIN Numbers or Cap 
Codes, you will need the PIN Number or Cap Code for your wireless receiver. Otherwise, you will just 
need the Wireless Receiver Phone Number. If using Email (SMTP) you will need the e-mail address 
for your wireless receiver. 

2. The Service Provider Phone Number or Service Provider SNPP or WCTP Internet Address and 
Port or E-mail Server Address. The Service Provider phone number is the dialup number for your 
wireless messaging service, also sometimes called a Access Number, Terminal Number, Modem 
Number, Alpha Port phone number, or Short Messaging Service phone number. If you dial this number 
from a telephone, you should hear a screeching noise, like a fax machine. If connecting through the 
Internet, the SNPP or WCTP address and port are used to transmit your message to the service 
provider; the E-mail Server address is used to relay your message through the Internet mail system.

If you are unsure of any of the required information, contact your wireless messaging or short 
messaging service.
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Installation

Access Rights and Watch-IT ASCII
For proper operation, Watch-IT ASCII requires certain file and directory access rights to be properly set, 
especially if the message directory is located on a network drive. Before installing Watch-IT, check that the 
following access rights are properly set.

Note: Novell rights are shown. If you are using a different network operating system, set the access rights 
to the equivalent rights on your network.

Key:

R Read
W Write
C Create File
E Erase or Delete File
M Modify File
F Filescan and Directory Control (i.e., rename a file)

Item Rights

Program Directory RWCEMF

Message Directory RWCEMF

Note: If you are installing the message directory on a local hard drive, the access rights are probably set 
correctly. You will most likely only have to modify access rights if you set up the message directory on a 
network drive (see “ASCII File Options” on page 32 for details on setting up the message directory).

Windows Networks
For Windows networks, set the access type for file sharing to SHARED with FULL access for the drive and 
directory that is being shared.
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Installing Watch-IT
Note: The installation procedure listed here is for Watch-IT ASCII or Watch-IT Serial. If you are installing 
Watch-IT ASCII SV, please refer to “Installing Watch-IT ASCII SV” on page 12.

1. If  Watch-IT has been provided on a floppy disk, make a back-up copy of your Watch-IT floppy 
disk before use.

2. To install InfoRad Watch-IT on your computer hard drive, click on the Start button, and select 
Run. Browse to your CD or floppy drive and select SETUP.EXE, and then click on OK.

3. The InfoRad Watch-IT Installation wizard license agreement screen will appear. Click on the “I
agree” button to continue the installation of InfoRad Watch-IT.

4. The Watch-IT Installation wizard will appear. Click on the Next button or press Return to continue 
the installation of Watch-IT.

5. Next select Program Access for Current User or ALL Users. Selecting Current User will store 
Program Settings in the Windows Current User Registry. Selecting ALL Users will store the 
Program Settings in the Windows Local Machine Registry (All Users). Selecting ALL Users may 
require Administrative privileges.

6. You are then prompted for a destination directory for the installation. If you wish to change the 
directory where the Watch-IT application will be installed, click on the browse button and select a 
new directory. Otherwise, click on the Next button to continue the installation process.

Note: If you are re-installing or upgrading Watch-IT, the installer will also ask if you wish to use 
the existing messaging database files and program setup files, or replace them.

7. You are then asked if you wish to create a shortcut on the desktop for the Watch-IT application. 
Click on the Next button once you have made a selection.

8. Ready to Install! Click next and Setup will then install the program files.

Once the program files are installed, the program will prompt you for program setup information. 
Click on the Next button to begin the program setup.

9. Select whether you will be using a Modem (dial-up Messaging Service or ISP) or 
network/DSL/Cable Internet connection to send messages. If you will be using both, select 
Modem to start the Modem Setup Wizard.

10. If you selected Modem above, the Modem Setup Wizard will begin. Click Next to go to 
Communications Setup. (See “Communications Setup” on page 18 for full details on the 
communications setup procedure.) Please note if you are using a dial-up Internet connection, after 
Setup completes you will need to select the Internet Connection to use (Setup Menu / Internet 
Settings).

11. Next, if you purchased the retail version of InfoRad Wireless Office, the Wireless Messaging 
Service wizard is started. Enter the default wireless messaging service information as prompted. 
(See “Building Your Wireless Messaging Services Directory” on page 46 for details).
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12. After you have entered a default wireless messaging service, the Add Wireless Receiver wizard is 
started. Enter at least one receiver number, and click Finish when finished. (See “Building Your 
Wireless Receiver Directory” on page 55 for details on adding wireless receivers to the messaging 
database).

13. After you have set up your default messaging service, the ASCII File Setup screen or Serial 
Monitoring Setup screen is opened, depending on which version of Watch-IT you are installing:

If you are installing Watch-IT ASCII, the ASCII File Setup screen allows you to configure how 
Watch-IT ASCII will process message files. See “Watch-IT ASCII and SV Setup” on page 31 for 
details.

If you are installing Watch-IT Serial, the Serial Monitoring Setup screen allows you to configure 
the serial port that Watch-IT Serial will monitor for message files. See “Watch-IT Serial Setup” on 
page 39 for details.

14. Click on the Register Now or Register Later buttons. If you choose to Register Later the 
Registration dialog is accessible from the Setup menu after installation.

If you select the Register Now button, the program will automatically open your internet browser 
to the InfoRad Product Registration website.

Registration is necessary for technical support and notification of future upgrades

15. Your Watch-IT installation is now complete. To run Watch-IT, click on the Watch-IT icon located 
in the InfoRad Wireless program manager group.
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Installing Watch-IT ASCII SV
Note: The installation procedure listed below is for Watch-IT ASCII SV. If you are installing Watch-IT 
ASCII or Watch-IT Serial, please refer to “Installing Watch-IT” on page 10.

Watch-IT ASCII SV Installation Overview
There are two separate software “modules” for Watch-IT ASCII SV:

Watch-IT ASCII SV 
Service Module

This is the background messaging “engine.” There is 
no direct user interaction possible with this module –
configuration is done through the Service Controller 
module. The Service module only runs on the 
computer designated as the Messaging Server.

Watch-IT ASCII SV 
Service Controller

The Services Controller is an administrative module 
for configuring and maintaining the Watch-IT ASCII 
SV Services messaging engine. This module can be 
run from the messaging server PC or remotely from 
any other PC on the network (running Windows®
2000 and greater). The user running the Service 
Controller must have administrative privileges on the 
system running the Service Module.

To use InfoRad Watch-IT ASCII SV, you must have a computer with Internet connectivity (and/or Hayes-
compatable modem if utilizing Dail-up TAP services) to run the Service module (we will be referring to 
this computer as the “messaging server”). The service module should be installed directly onto this 
computer.

NOTE: The Service Controller module can be run from any computer, but the communications setup can 
only be accessed when the Service Controller is run directly on the messaging server.
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SV Service Module and Controller Installation
NOTE: Installing Internet downloaded Watch-IT ASCII SV file. The download file will install the Watch-
IT ASCII SV Service (follow steps 1, & 4-6 in “Watch-IT ASCII SV Service Module Installation”). During 
the Service installation a Controller setup file is copied into the Watch-IT ASCII SV Service folder. Run 
the ‘Contoller Setup.exe’ file to install the Watch-IT ASCII SV Controller (follow steps 7-12 in “Watch-IT 
ASCII SV Service Controller Installation”).

To install the Watch-IT ASCII SV from disk: first install the ASCII SV Service Module (Watch-IT ASCII 
SV Service Module Installation), then the ASCII SV Service Controller (Watch-IT ASCII SV Service 
Controller Installation).

Watch-IT ASCII SV Service Module Installation

1. On the computer you have designated as the messaging server (this computer must have Internet 
connectivity and/or Hayes-compatable modem), log in as the Administrator.

2. Insert the installation disk into the floppy drive or CD drive.

3. Click on the Start button, and select Run. Browse to your CD or floppy drive and select 
SETUP.EXE, and then click on OK.

4. Select the directory where you would like to install the software. (By default this is “C:\Program 
Files\InfoRad Watch-IT ASCII SV Service”.) 

The service program and database files will then be installed into the specified installation 
directory.

5. When the module has been installed, reboot the computer when prompted.

6. Ensure that the installation directory for the service module is shared and that all client 
computers will have full rights to the message directory. The installation program cannot share 
these directories automatically.

Watch-IT ASCII SV Service Controller Installation

7. Once the computer has rebooted, login again as the Administrator.

Click on the Start button and select Run. Browse to your CD or floppy drive and select 
CNTSETUP.EXE, and then click on OK. (This is the “Controller Setup” from the installation 
disk.)

8. Select the directory where you would like to install the Service Controller (by default this is 
C:\Program Files\InfoRad Watch-IT ASCII SV Controller).

9. Once the Controller installation is complete, select “InfoRad Watch-IT ASCII SV Controller” 
from the Start>Programs menu.

10. When the Service Controller asks which computer you would like to connect to, select “Service on 
This Computer.”

11. When prompted to select the path to the database files, select the installation directory. Double-
click on any of the .IRT files listed in the directory.

12. Set up the messaging server communication settings (Edit Menu, Communications. Reference the 
Watch-IT manual for Communications setup instructions).

13. If you wish, you can also set up the paging services, wireless receivers, and messaging groups at 
this time. (Edit Menu, Messaging Services, Receivers, Receiver Groups. Reference the Watch-IT 
Manual for further instruction.)
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Remote Service Controller Installation
1. If you wish to administer the service module from another computer on the network, take the 

installation disk to that computer, login as the administrator, and then run the “CNTSETUP.EXE” 
program on the installation disk to install the Service Controller. (For Interent downloaded 
products, browse to the shared Watch-IT ASCII SV Service folder on the Messaging Server and 
run ‘Controller Setup.exe’.)

2. When you run the Service Controller from a remote system you must be logged in with a Login 
that has Administrator rights on the system running the Service module. When the Service 
Controller asks which computer you would like to connect to, select “Service on a Remote 
Computer” and enter the name of the remote computer (such as “Server1”).

3. When prompted to select the path to the database files, select the installation directory. Double-
click on any one of the .IRT files listed in the directory.

4. You can now access the Edit and Setup options from the Edit Menu.

NOTE: The Service Controller module can be run from any computer, but the communications setup can 
only be accessed when the Service Controller is run directly on the Messaging Server.
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Installation Problems?
Should you require additional assistance with InfoRad Watch-IT, please briefly document your problem 
and questions, serial number and version number. 

Technical Support Options
Technical Support is only available to registered users of the software as detailed in the licensing 
agreement. Please register if you haven’t already.

This program is licensed with 90-days free telephone technical support included. AlphaCare Subscription 
options are available that extend the support period, as well as offer priority telephone support and Upgrade 
Protection. Out-of-warranty support is also available on a per-incident basis..

Please call InfoRad Sales at (800) 228-8998 for details on AlphaCare, or e-mail to sales@inforad.com, or 
see our website at www.inforad.com.

InfoRad Software Technical Support is available Monday through Friday 8:30–5:30 ET.

A technical support section with solutions to common problems is also available at 
www.inforad.com/techsupport

Phone: (216) 531-1369

E-mail: techsupport@inforad.com

Internet: www.inforad.com
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General Setup Options

Setup Overview
Your InfoRad Watch-IT software is configured for compatibility with your 
computer system during installation. InfoRad Watch-IT provides you with 
additional communications options should your system or personal needs 
require them. Access to these features is achieved by selecting the option 
from the Setup menu.

There are four main setup options:

 Communications Setup

 Internet Setup

 Preference Options

 Change Graphics Option

In addition, there are setup sections that are specific to each version of Watch-IT:

 Watch-IT ASCII and SV Setup

 Watch-IT Serial Setup

Please refer to the section appropriate to your version of Watch-IT.
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Communications Setup
The Communications Setup defines the settings and options used by InfoRad Watch-IT when connecting to 
Messaging Services that are programmed to connect via ‘modem dialup (TAP)’.

InfoRad Watch-IT uses the Windows communications settings and dialing properties, allowing you to 
easily use your current Windows modem settings when setting up InfoRad Watch-IT. In addition, there are 
several modem configuration options that you can use to further define how InfoRad Watch-IT uses your 
modem.

To setup InfoRad Watch-IT’s communication settings, select Communications from the Setup menu. The 
Communications Setup  dialog is displayed.
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Modem Dialup Connection Settings
The Modem dialog lists all available modems on the current system and modem configuration settings. 

When you are finished with the modem selection and configuration, click on OK to finish the 
communications setup process.

Use this modem to send messages: Click on the drop-down box to select the modem you wish to use with 
InfoRad Watch-IT.

Modem configuration: The standard Windows modem settings should work with InfoRad Watch-IT. 
However, if you should need to modify the modem settings for use with InfoRad Watch-IT, additional 
modem configuration settings are available from within the Modem dialog.

From this dialog you can change the following options:

 Modem Configuration

 Communications Log

 Flow Control

Note: InfoRad Watch-IT uses your Windows settings to determine what 
modems are available and how to dial phone numbers. To modify the 
dialing properties in Windows click on the Dialing tab in the 
Communications Setup screen.
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Modem Configuration

If your modem requires a unique initialization string, select “Override the system’s modem configuration, 
use this initialization string instead:” and enter your modem’s initialization string:

1. If you are unsure of what initialization string you should use, try using the “Create” button. 
InfoRad Watch-IT will automatically build a custom modem initialization string for your modem.

2. If the custom initialization string built by “Create” does not work, enter a custom modem 
initialization string manually. See “Using High Speed and Fax Modems” on page 21 for more 
information on creating a custom initialization string.

Note: If you change the modem selection in Communications Setup, you must first Click on the Apply 
button to activate the Create function to allow automatic setup of an initialization string for the newly 
selected modem.

Flow Control

The flow control settings allows you to enable/disable modem flow control, and select between software 
(XON/XOFF) flow control and hardware (RTS/CTS) flow control (default setting). Normally there is no 
need to change this setting.

Communications Log

The “Keep a log of communications activity for diagnostic purposes” checkbox enables communications 
logging of all modem connections to a files named CM*.txt, which is saved in the program installation 
directory.

The log filename is CM, followed by the day of the month, followed by the time of day - for example, a 
message or group of messages sent on the 6th day of the month at 9:15am would have a log file with the 
name CM060915.txt.; at 9:15pm the filename would be CM062115.txt
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Using High Speed and Fax Modems

If you need to use a custom modem initialization string and are using a Fax modem, a high-speed modem 
(above 2400 baud), or a modem with error correction or data compression features, several of your 
modem’s advanced features will typically need to be disabled to achieve successful communications with a 
wireless messaging service’s answering modem. 

If you are not familiar with the proper commands, syntax, or command order for your particular modem, 
please reference your modem user manual or contact your modem manufacturer’s technical support staff. 
Also note the following settings for a typical initialization string:

 Select Bell mode (For U.S.)
 Select CCITT mode (For European and other countries)
 Error correction = OFF
 Data compression = OFF
 Auto baud adjust = OFF or ON
 Return verbal result codes = ON (typically Q0V1)
 Extended result codes (typically X4 to return BUSY, NO DIAL TONE and CONNECT message 

with speeds)
 Flow control = OFF
 Operation mode = Normal mode
 Modem reset on DTR transition = ON
 Trellis Encoding = OFF
 Communications mode = asynchronous

Note: Try adding an &F at the beginning of the init string to reset modem before issuing other commands. 
Try setting the operation mode to direct mode if normal mode fails. Some modems use the “+MS” 
command to set the speed of the modem. A typical setting will look like the following:

+MS=B103         for a 300 baud rate connection

+MS=B212         for a 1200 baud rate connection

For more information on modem configuration, please see http://www.inforad.com/modemtech.html
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Internet Setup
Access the Internet Setup by selecting Internet Settings from the Setup Menu.

Internet Setup section allows you to configure:

 Internet Connection Settings

 Telnet Proxy Setup Options

 Other (Internet Setup)

Internet Connection Settings
These settings are used for internet-based messaging services (WCTP, SNPP, SMTP(E-mail)). The 
following are the Internet connection options:

Connect to the Internet through: You can configure the software to connect to the Internet through 
your local network, or you can select a dial-up Internet connection. If you select a dial-up Internet 
connection, you will need to enter the login account name, account password, and optional domain 
name.

Reconnection options: These settings define the number of redial attempts to connect to Internet if a 
connection or logon problem occurs (such as a busy signal).

HTTP Proxy Server Authentication: WCTP Messaging Services utilize the HTTP Internet protocol 
in the same way as your Internet Browser. If your network contains a Proxy Server that requires 
Authentication to access the Internet, check 'Proxy server requires authentication' and enter your 
Username and Password required for Internet Access. (Note for Watch-IT ASCII SV: The Watch-
IT ASCII SV Service accesses the HTTP Proxy. The Watch-IT ASCII SV Service Logon 
properties must use a logon account that will allow the Service both admin rights to the machine 
running the Service and network access to the HTTP Proxy.)

Keep a log of internet activity for diagnostic purposes: This option enables logging of all internet 
connections. This is useful to confirm that the computer is successfully connecting to the Internet 
to transmit messages. When this option is enabled, a file named “inetlog.txt” is saved in the 
program installation directory. This file contains a log of all internet activity generated by the 
program, including connection attempts and sent messages.
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Telnet Proxy Setup Options
When sending messages via SNPP to a Messaging Service through a network Internet connection that 
utilizes a proxy server or firewall for network security, it may be necessary to setup InfoRad Watch-IT to 
use a telnet proxy. This may be required since SNPP is not a common port that is open on most Proxy 
servers or Firewalls. Check with your network administrator to determine if you must use a Telnet Proxy 
and for proper settings. 

Select the “Use a telnet proxy for SNPP services” checkbox to enable the use of a telnet proxy in the Telnet 
Proxy tab of Internet Setup.
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Use a telnet proxy for SNPP services: If you are using a proxy or firewall with your internet connection, 
you can select this checkbox to enable proxy use and to specify the proxy settings, including the proxy 
address and port number. Note that telnet proxy is used only for SNPP Services. (WCTP and SMTP 
Services will not use a telnet proxy. WCTP connects via an HTTP Proxy if the network requires; SMTP 
connects via an SMTP server located on your network or at your ISP.)

Telnet Proxy Address and Port: This is the address and port number of the proxy server being used.

Telnet proxy responses: The “Telnet prompt” options specifies the prompt text that the proxy server 
displays to indicate that it is ready for input. Note that if your Telnet prompt contains a space after the 
prompt (and before the cursor), you must enter the space as part of your "Telnet prompt" text entry. (To 
determine your telnet prompt, open a command window and establish a telnet connection to your telnet 
proxy server. The command prompt that is returned is your "Telnet prompt".)

Telnet proxy commands: The “Connect command” is the command the proxy server will use to connect 
to the messaging service Internet server. Note: to send the proxy address, enter “ADDRESS”. To send the 
proxy port, enter “PORT”.

Example: If you enter “CONNECT ADDRESS PORT” in the Connect command field, and your Messaging 
Service SNPP Internet server address is “snpp.alphatech.com”, and the port is “444”, InfoRad Watch-IT 
will send the command “CONNECT snpp.alphatech.com 444” when connecting to the messaging service 
Internet server through the Telnet Proxy.

Normally, the proxy connect command is “ADDRESS PORT” or “CONNECT ADDRESS PORT”. Check 
with your network administrator for the proper commands for your proxy server.

Flow of a Telnet proxy connection: When sending a message utilizing a Telnet Proxy Server, InfoRad 
Watch-IT first establishes a telnet connection to the proxy as defined in the Telnet Proxy Address and Port. 
When InfoRad Watch-IT detects the Telnet prompt (as defined in the Telnet Proxy Setup), it then sends the 
Connect command (as defined in the Telnet Proxy Setup) using the ADDRESS and PORT as defined in the 
Messaging Service. The Telnet Proxy then establishes a connection to the Messaging service.  InfoRad 
Watch-IT then sends the message to the Messaging Service via the connection established by the Telnet 
Proxy.
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Other (Internet Setup)
InfoRad Watch-IT supports sending messages to wireless receivers via Internet E-mail using the standard 
Internet E-mail protocol SMTP. 

To send messages via e-mail please reference the Messaging Service setup.

The Other tab in Internet Setup allows you to define the Reply-To Address for messages sent via E-mail 
(SMTP) and WCTP. Enter your Internet E-mail address in the field. Note that some E-mail servers may 
reject messages that do not have a Reply-To Address defined.

The Subject Line field is used as the E-mail Subject in E-mail (SMTP) messages. Note that some e-mail 
servers may reject messages that do not have a subject defined. The subject line can also be used with some 
SPAM filter software to allow the message through the SMTP server. For example an SMTP Server SPAM 
filter may be defined to allow messages with ALERT as the subject to be processed.

If no entry is made in the address field, then message responses and failed to send notices will not be 
returned.

NOTE: Some WCTP Messaging Services require the use of a senderID. The Reply-To Address field 
will be used as the senderID (in addition to being used as the reply address) when connecting to 
WCTP services.
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Preference Options
InfoRad Watch-IT offers you several wireless receiver preference options for handling long message input, 
entering a message “signature,” and more. To set or select your Preference Options, select Preferences 
under the Setup menu. The General Preferences dialog will appear.

General Options

Split long messages into multiple pages: Selecting this option allows you to send messages up to 1024 
characters long. Your message is automatically split into shorter messages based on the message length 
capability defined when you set up your wireless messaging service’s information (see “Building Your 
Wireless Messaging Services Directory” on page 46).

Require confirmation for deleting and clearing items: This option allows you to select whether InfoRad 
Watch-IT will ask for confirmation upon deleting or clearing items from the Receivers, Groups and 
Messing Service Directory.

Send button sends all queued messages: This option allows you to select whether InfoRad Watch-IT will 
send all messages in the queue when sending a newly entered message. When not selected the behavior is 
to send only the newly entered message and queued messages must be sent from the Queue Menu, Send 
Queue.

Remove duplicate messages: This option allows you to select whether InfoRad Watch-IT will remove 
duplicate messages when sending to multiple Groups. If a Receiver belongs to multiple Groups, the 
message will be sent only one time if this option is selected. When not selected the behavior is to send the 
Receiver for each Group it is associated.

Password option

Password protect edit controls: Access for editing any of the InfoRad Watch-IT setup or directory entries 
is restricted by selecting this option. Once disabled, access is allowed only by your password. The InfoRad 
Watch-IT default password is “priv”.

Change Password: The password governs the “Edit” and “Setup” menu options. The default password is 
“priv”. To change the password, click on the Change Password button, enter your new password, and click 
on OK. Make sure to document the new password.
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Log File Location

Log File Location: Browse and create an alternate Log File folder location, if desired.

Message Signatire option

Message Signature: The message signature text allows you to define a short “signature” string of 
characters that will be attached to each message you send. For example, “John Smith, ARB Inc.” Type in 
the signature you wish to use in the Signature Text field, and select whether you want the signature inserted 
before or after each message. When you enter a text message, you will have the opportunity to turn the 
signature on or off.

Failed Message Retries Options

This option allows you to select the number of attempts that InfoRad Watch-IT will make when an error is 
encountered during sending of a message. For Dial-up TAP messages the program will also attempt redials 
upon the following conditions: receiving a telephone company busy signal while dialing the messaging 
service; if the modem is in use by another application; or if the phone line is in use (no dial tone).

There are several retry options available:

Retry when manually typed-in messages fail: This option allows you to select whether InfoRad Watch-
IT will automatically retry when sending a message that you entered and sent manually.

Retry when scheduled messages fail: This option allows you to select whether InfoRad Watch-IT will 
automatically retry when sending scheduled messages.

Retry attempts: Enter the number of times you wish the program to attempt to send a message that is 
receiving an error.

Seconds between attempts: Enter the number of seconds you wish the program to wait before retrying.

Bring retry window to foreground: If the program has to attempt to retry, selecting this option will bring 
the retry window to the foreground (in front of any other open windows).
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Scheduled Messages option

Send past due messages: This option allows you to send past due scheduled messages within a user 
selected time frame. Turning off this option (un-checking the option) will cause all past due scheduled 
messages to not be sent. If the message is a One-Time scheduled message, the message will be deleted if 
the scheduled send time is outside the selected time frame for sending past due scheduled messages. If the 
program has Advanced Scheduled messaging feature (Daily, Weekly, Monthly recurring scheduled 
messages), the next occurance will always automatically be scheduled after determining to send a past due 
message.  

If overdue less than: Select the time limit for sending past due scheduled messages from 1-Hour to 1-
Month.

Spell Check Option

Spell Check performs a spelling check of an entered message before sending and allows for correction. 

Options: You can use the Options Dialog to specify various spelling-checker options. These options affect 
the way the spelling-checker operates. Click on the Help button for information on available spelling-
checker options. 

Dictionaries: The Dictionaries Dialog allows you to open and close user dictionaries, and to edit the 
contents of an open user dictionary. The contents of dictionaries are saved in disk files. Click on the Help 
button for more information on Spell Check Dictionaries.
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Change Graphics Option
If you wish, you can change the background graphic and the text color used by the software. To modify the 
graphics, select the “Change Graphics…” option from the Setup menu.

To select a picture to use as the backdrop, enter the directory path and filename of the graphic, or click on 
the Browse button and then select the graphic file you wish to use.

Next, select a backdrop style: None, Stretch to fit, Centered, or Tiled.

To change the color of the text used in the main screen, click on the Pick Text Color button, and then select 
the color you wish to use.

When you click on the Ok button, your graphic preferences will be applied to the main screen.
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Watch-IT ASCII and SV Setup

ASCII Setup Overview
Note: This section applies to Watch-IT ASCII and Watch-IT ASCII SV only. For information on setting up 
Watch-IT Serial, please refer to “Watch-IT Serial Setup” on page 39.

The ASCII File Options dialog allows you to configure the Message Options Watch-IT ASCII will use to 
process message files. The ASCII File Options dialog can be accessed from the Setup menu (Edit menu in 
Watch-IT ASCII SV). 

The ASCII File Setup dialog allows you to modify the message file parameters and status file behavior. 
The ASCII File Setup dialog is accessed using the “Message Files…” button in the ASCII File Options 
screen.

For specific information and instruction, please refer to the following  sections:

 ASCII File Options

 ASCII File Setup

Watch-IT ASCII File Options Setup Screen

Watch-IT ASCII SV File Options Setup Screen

Note: The Watch-IT ASCII SV version does not include the “Check Interval” option. Watch-IT ASCII SV 
checks for messages every 10 seconds.
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ASCII File Options
The following are the available ASCII File Setup processing options:

Message Directory The “Message Path” field allows you to enter the directory to check for new message 
files. By default this directory is “<program directory>\MSG\”, however it can be changed to any 
directory on local or network drives.

(Note for Watch-IT ASCII SV: The Watch-IT ASCII SV Service accesses the Message Directory. If 
the Message Directory is not located on the Service machine, but is located on a network location, the 
Watch-IT ASCII SV Service Logon properties must use a logon account that will allow the Service 
both admin rights to the machine running the Service and network access to the Message Directory.)

Check Interval (Watch-IT ASCII only) The check interval option sets how often Watch-IT checks the 
message directory for new message files to process. By default this is set to five seconds.

Strip whitespace The strip whitespace option automatically removes any excess spaces from the contents 
(or message) of a wireless receiver message, converting multiple spaces into a single space. For 
example, the message “Frank,       give me a call      --  John” would be sent as “Frank, give me a call --
John”. An example reason to turn off this option is if you are formatting messages to fit a specific 
wireless receiver’s line format and use spaces in the message to accomplish this task.

Include time Selecting this option will automatically insert the time that Watch-IT sent the wireless 
receiver message into the message text.

Include day Selecting this option will insert the day (abbreviated to three letters, such as Mon or Tue) that 
Watch-IT sent the wireless receiver message into the message text.

Include date Selecting this option will insert the date (without the year) that Watch-IT sent the wireless 
receiver message into the message text.

Include year Selecting this option will insert the year that Watch-IT sent the wireless receiver message 
into the message text. If the “Include date in page” option is also selected, the year is appended to the 
date.

Include sender Selecting this option will insert the text included on the “FROM:” line of the message file 
into the wireless receiver message. (Note: the “FROM:” delimiter can be user-modified. See “Message 
Delimiters Setup” on page 38 for more information on changing message delimiters.)

Create status files This option allows Watch-IT to create status files, which are files used to track the 
current status of pages being processed by the system. This option is explained in detail in “Status Files 
Filename Setup” on page 36.
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ASCII File Setup
The ASCII File Setup dialog allows you to modify how Watch-IT processes message files, including 
changing the filenames that Watch-IT looks for, changing the names of the status files created after each 
wireless receiver message is sent, and modifying the delimiter text headers that specify the different 
sections within the message files.

The ASCII File Setup dialog box is accessed from the “Message Files” button in the ASCII File Options 
dialog.

Old-Style and New-Style File Conventions
There are two ASCII file conventions used for naming status files, “old-style” and “new-style.” Watch-IT 
ASCII, AlphaPage Windows AFP, and AlphaPage DOS AFP support the convention known in Watch-IT 
ASCII SV as “old-style” scheme. In addition to the old-style scheme, Watch-IT ASCII SV also supports a 
new ASCII File convention known as the “new-style” scheme.

The  ASCII File Options dialog in Watch-IT ASCII SV allows setup of either or both schemes. The Watch-
IT ASCII SV supports both schemes for backward compatibility. Watch-IT ASCII SV can support either 
scheme independently or simultaneously.

ASCII File Setup “Old Style” ASCII File Setup “New Style”

“Old-style” and “new-style” use different initial / default settings of File Names and Status File Names. 
The “new-style” utilizes a client ID in the “new-style” message file names (the use of a client ID is optional 
for your application – you may name the files as you desire, even use the “old-style” filenames in the “new-
style” settings).
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New-Style Message File Processing Example

When a message is sent from one of the external third part clients, the client:

1. obtains a message ID from its own local source (let’s suppose it’s 00008759 for our example)

2. updates its local source to the next message number (00008760 in our case)

3. obtains its client ID from its own local setup file (let’s suppose it’s 00000012 for our example)

4. creates a message file with its message ID and its client number 
(MESSAGE__00000012.00008759).

The server watches out for the appearance of MESSAGE__*.* files. When the server sees the 
message file (MESSAGE__00000012.00008759) it:

5. parses the file, attempts to read any messages contained in it

6. erases the MESSAGE__00000012.00008759 file.

7. creates a file to indicate that the message is in process: PROCESS__00000012.00008759

8. attempts to send the message

9. creates a file to indicate that the message was sent (SENT_MSG_00000012.00008759) or that the 
message failed (ERR_MSG__00000012.00008759).

The client waits, and watches for the presence of one of two filenames: 
SENT_MSG_00000012.00008759 or ERR_MSG__00000012.00008759.

10. If the ERR_MSG__ file is present, it is read to find out what went wrong.

11. If the SENT_MSG_ file is present, the client assumes the message was sent OK.

12. In either case, the client erases the PROCESS__00000012.00008759, 
SENT_MSG_00000012.00008759, and ERR_MSG__00000012.00008759 files, if they exist.

Old-Style Message File Processing Example

When a user sends a message from one of the clients, the client:

1. obtains a message ID from the global source (let’s suppose it’s 247 for our example)

2. updates the global source to the next message number (248 in our case)

3. creates a message file with the message ID (PAGEMSG.247 in our case)

The server watches out for the appearance of PAGEMSG.* files. When the server sees our message file 
(PAGEMSG.247) it:

4. parses the file, attempts to read any messages contained in it

5. renames the file to the in-process file name (PAGEMSGI.247 in our case)

6. attempts to send the message, if any

7. creates a file to indicate that the message was sent (PAGEMSGS.247) or that the message failed 
(PAGEMSGE.247).

The client waits, and watches for the presence of one of two filenames: PAGEMSGS.247 or 
PAGEMSGE.247.

8. If the PAGEMSGE file is present, it is read to find out what went wrong.

9. If the PAGEMSGS file is present, the client assumes the message was sent OK.

10. In either case, the client erases the PAGEMSGI.247, PAGEMSGS.247, and PAGEMSGE.247 
files, if they exist.
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Message Filename Setup
The first four fields in the Message File Setup dialog allow you to specify the filename which Watch-IT 
ASCII will use when checking for message files and when generating status files.

Message Filename Format

The Unsent message filename field in the Message File Setup dialog allows you to define the format of the 
filename that Watch-IT ASCII will search for when it checks the message directory for new message files.

Watch-IT supports standard DOS filename formats (8 characters, a period, and a three-character extension) 
and long filenames. You can enter a full filename, or replace a part of the filename with a wildcard (* or ?) 
character. The “*” wildcard character will match any number of characters, while the “?” wildcard 
character only matches a single character. Using wildcards allows you to set the filename or the extension 
as a variable.

For example, entering “PAGEMSG.*” into the Unsent message filename field would enable Watch-IT to 
match any filename placed into the message directory that began with PAGEMSG. This would allow you 
to use the extension to number the message files, such as PAGEMSG.001, PAGEMSG.002, and so forth. 
Entering “PAGEMSG.?” would only match single-character extensions, such as PAGEMSG.1, 
PAGEMSG.2, and so on—“PAGEMSG.12” would not match.

You can also define the extension, and leave the filename as a variable. For example, *.MSG would match 
any file that had the MSG extension, such as ACCESS.MSG, 00341.MSG, or JAN0197.MSG

Note: If you use the extension for wireless receiver message numbering, Watch-IT also supports base 36 
numbering schemes in addition to standard decimal numbering (base 36 uses numbers ranging from 1 to Z, 
allowing numbers such as 03Z).

Default Old-Style Message Filename

The default old-style message filename format is PAGEMSG.*, where the extension is used for a message 
ID number. This number is incremented with each processed message file.

Sample Old-Style Message Filename:
PAGEMSG.764

Default New-Style Message Filename

The default new-style message filename format is MESSAGE_*.*, using both a client ID number and a 
message ID number. 

Sample New-Style Message Filename:
MESSAGE_00000012.00008759
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Status Files Filename Setup

Watch-IT ASCII and Watch-IT ASCII SV can create several kinds of status files that contain information 
about the success of the page sent. (This option is enabled by selecting the “Create status files” checkbox in 
the ASCII File Setup dialog.)

Status Files Format

You can define the filenames used for each of the following types of status files generated by Watch-IT:

Inprocess/Input Message Files: This is just the message file with a new name. The filename is 
changed to prevent the AFP from attempting to send the messages in it again. The system that 
created the message file can remove this file or use it for whatever purpose it chooses. If you have 
not selected the “Create AFP status files” checkbox, the message file is deleted once it has been 
processed.

Sent Message Files: This file contains the recipient name, the messaging service used, the exact 
message text sent to the wireless receiver, and the date and time that the message was sent. This 
can be useful if the system needs to keep track of what messages were sent when. This file is only 
created if the messages was sent successfully, so its presence is an indicator that the message was 
sent.

Error Message Files: This file is only created if there is a problem sending a wireless message. This 
file contains the same information as the Sent File, plus an error message to help diagnose the 
problem.

The names of each of these files can be user-specified. Watch-IT can be set up to leave separate error files 
for each message file, or to leave all status information in one set of three status files.

Default Old-Style Status Filenames

The following are the default status filename formats used in the old-style scheme:

Status File Default Filename Format

In-process PAGEMSGI.*

Sent Message PAGEMSGS.*

Error Message PAGEMSGE.*

In the old-style scheme, the extension is used for a message ID number. This number is incremented with 
each processed message file.

Sample Old-Style Status Filenames:

PAGEMSGI.764
PAGEMSGS.764
PAGEMSGE.764



InfoRad Watch-IT Watch-IT ASCII and SV Setup  37

Default New-Style Status Filenames

The following are the default filenames used in the new-style scheme:

Status File Default Filename Format

In-process PROCESS_*.*

Sent Message SENT_MSG_*.*

Error Message ERR_MSG_*.*

In the new-style scheme, the extension is used for a message ID number, and a client ID number is 
appended to the end of the filename before the filename extension.

Sample New-Style Status Filenames:

PROCESS_00000012.00008759
SENT_MSG_00000012.00008759
ERR_MSG_00000012.00008759

Creating Individual Status Files for Each Wireless receiver Message

For individual (separate) status files for each wireless receiver message, use either a wildcard filename or a 
wildcard extension. For example:
*.INP
*.SNT
*.ERR

All wireless receiver status messages would be created with individual filenames, assuming every message 
file had a unique file name. For example, files MSG001.txt and MSG002.txt would result in MSG001.INP 
and MSG002.INP, and the same for sent or error files.

You can also use variable extensions like the old-style default setup:
pagemsgI.*
pagemsgS.*
pagemsgE.*

All status messages generated by this configuration would have the defined filename, and an individual 
extension, assuming every wireless receiver message file had a unique extension.  For example, files 
pagemsg.001 and pagemsg.002 would result in pagemsgi.001 and pagemsgi.002, and the same for sent or 
error files.

Creating Just One Set of Status Files

To configure Watch-IT to generate just one of each type of status file (instead of creating a set of status 
files for each individual wireless receiver message file) use a static name with no wildcard:
pagemsg.inp
pagemsg.snt
pagemsg.err

Note: In this configuration, Watch-IT will append to the Sent Message and Error Message status files each 
time a wireless receiver message is sent. However, the Inprocess/input Message file (pagemsg.inp in the 
example above) is overwritten each time a message file is processed.
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Message Delimiters Setup
Watch-IT ASCII and ASCII SV allow you to customize the delimiters that mark the different sections of a 
messaging message file, such as the “TO:” and “CONTENTS:” delimiters. This allows you to customize 
the way Watch-IT processes message files to match the application generating the files.

The following are the default message delimiters:

Section Default Delimiter

Message Header MSG:

Sender Name FROM:

Recipient Name TO:

Message Text CONTENTS:

Comments **
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Watch-IT Serial Setup

Serial Setup Overview
Note: This section applies to Watch-IT Serial only. For information on setting up Watch-IT ASCII, please 
refer to “Watch-IT ASCII and SV Setup” on page 31.

There are two setup sections used to set up Watch-IT Serial to monitor and process messaging information:

 Serial Monitoring Setup

 Serial Alarm Code Mapping

The Serial Monitoring Setup screen allows you to configure how Watch-IT Serial will monitor for records 
to process. The Serial Monitoring Setup dialog is automatically opened during the installation process, and 
can also be accessed from the Setup menu.

The Serial Alarm Code Mapping screen allows you to specify the codes which will cause Watch-IT 
Serial to generate a wireless message, and which receivers will receive the message for each alarm code.

Once you have configured the serial monitoring options and defined the alarm codes, Watch-IT Serial is 
ready for operation.
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Serial Monitoring Setup
The Serial Monitoring Setup screen allows you to configure how Watch-IT Serial will monitor for records 
to process.

The Serial Monitoring Setup screen  is automatically opened during the installation process, and can also be 
accessed from the Setup menu.
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Serial Monitoring Setup Options
The following are the setup options available from the Serial Monitoring Setup screen:

Serial Data Input Port Settings: These settings allow you to specify the communications port that 
Watch-IT Serial will monitor, as well as the port speed and parity settings. These settings should match 
the communication settings on the system that will be generating the serial communications.

If Alert Message Fails: This option allows you to specify the number of times Watch-IT Serial should 
attempt to retry to send the message, and whether it should notify the receiver titled “ADMIN” if a 
message fails. For the ADMIN notification to work, you must have a wireless receiver defined with the 
name of “ADMIN” in the messaging database. Typically, this will be the system administrator. For 
details on adding wireless receivers, please refer to “Building Your Wireless Messaging Services 
Directory” on page 46.

SIM input records end with: This option specifies the character used to mark the end of a record. 
Typically, this is either a line feed or a carriage return – for Microsoft-based systems (Windows or 
DOS) it will most likely be a line feed. Select the appropriate option for your system. If your system 
does not use a line feed or carriage return to mark the end of a record, enter the ASCII code of the end 
of record character used by your system. Note that the character used to mark the end of a record 
cannot appear anywhere within the body of the record.

Alarm Code Default Settings: The alarm code default settings are the settings which will appear each 
time a new serial alarm code is added to the database. (See “Serial Alarm Code Mapping” on page 42
for full details on each of these options.)



42  Watch-IT Serial Setup InfoRad Watch-IT

Serial Alarm Code Mapping
The Serial Alarm Code Mapping screen allows you to specify the alarm “trigger” codes which will cause 
Watch-IT Serial to create a wireless message, and also specify which receivers will receive the message for 
each specific alarm code.

From the Serial Code Mapping screen, you can add, edit, and delete alarm codes.

 To add a new alarm code, click on the Add Code button.

 To edit an existing code, select the code from the “Alarm Code” column and click on the Edit 
Code button.

 To remove an alarm code, select the code and click on the Remove Code button.
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Edit Serial Code Dialog
If you select the Add Code or Edit Code buttons from the Serial Alarm Code Mapping screen, the Edit 
Serial Code dialog will open.

The following are the available serial alarm code options:

Alarm Code: This is the text that specifies the alarm code. The alarm code should match the text generated by 
the host system. It could be a text message, such as “NOTICE” or an application-specific code, such as 
“AN534”.

Alarm Code Starts: This option allows you to specify whether the alarm code starts at a specific column 
position in the record, or if the code can appear anywhere within the record. If the alarm code starts at a 
specific location in the record, enter the starting column position.

Include Record Text: The Include Record Text option allows you to include a specific range of text from the 
record. Specify the starting and ending columns of the record text you wish to include in the wireless 
message.

Additional Record Text: If you wish to include a second range of text from the current record, select this 
option and enter the starting and ending columns of the second portion of the record text you wish to 
include in the wireless message.

Additional Text: The Additional Text option allows you to append a custom text string to each wireless 
message generated by the current alarm code. Enter the text you wish to include.

Date and Time: To include the date and time the wireless message was created, select this option.
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Assigning or Removing Receivers to an Alarm Code
Once you have defined an alarm code, you will need to assign wireless receivers to receive the message. 
You can specify either individual recipients or groups, or a combination of both.

All recipients and groups in the messaging database are listed in the “Recipients/Groups” column of the 
Serial Code Mapping dialog. All recipients and groups assigned to the current alarm code are listed in the 
“Sends To” column.

To add a recipient or group to the current alarm code, select their name from the “Recipients/Groups” 
column and click on the “<<< Add” button. To remove a recipient or group, click on their name in the 
“Sends To” column and click on the “Remove >>>” button.

Note: If the recipient or group you wish to add is not listed, they are not currently defined in the database. 
To add a recipient or group, click on the “Add Recipient” or “Add Group” button to open the Wireless 
Receiver Directory or Group Directory. (See “Adding a New Wireless Receiver” on page 58 or “Adding a 
New Group” on page 61 for more information).
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Building Your Wireless 
Messaging Directories

Messaging Directories Overview
Watch-IT lets you select wireless receivers for text messages by Name and by Group. To do this, you must 
first create the following three messaging database directories (Wireless Messaging Service, Wireless 
Receivers, and Group) in the following order:

 Building Your Wireless Messaging Services Directory

 Building Your Wireless Receiver Directory

 Building Your Group Directory (Optional)

These directories contain information about messaging service companies, individual wireless receiver 
numbers, and grouped listings of receivers that you wish to send text messages to as a set (such as a sales 
team or emergency action group).

Also note, you can send a message manually from the Watch-IT ASCII and Serial main screens by wireless 
receiver number (See “Sending Messages By Receiver Number” on page 83 for more details). This option 
is not available in Watch-IT ASCII SV.
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Building Your Wireless Messaging Services 
Directory

The Wireless Messaging Service Directory is a database of messaging companies, including information on 
each company’s wireless messaging service number (and related communications information). Watch-IT 
allows you to set up as many wireless messaging service entries as you require.
You will need a separate entry for each different company used by those wireless receivers you wish to 
message—for example, if you are sending messages to one wireless receiver using a nationwide messaging 
service and to another using a local messaging service, you will need to create two messaging service 
directory entries.
There are two messaging service setup methods. To quickly add a new modem-based wireless messaging 
service, you can use the "Add a Messaging Service" wizard. For more advanced setup options, or to edit an 
existing messaging service, you can manually edit the service’s configuration.
To access either setup method, select “Messaging Services...” from the Edit menu to open the Listing of 
Messaging Services screen, which lists all currently defined wireless messaging services and their current 
call and packet counts. From this screen you can add, modify, or delete a messaging service.
Note: Setup wizards are not available in Watch-IT ASCII SV. To set up your wireless messaging services, 
please refer to “Manually Adding or Editing a Messaging Service” on page 47.



InfoRad Watch-IT Building Your Wireless Messaging Directories  47

Manually Adding or Editing a Messaging Service
From the Listing of Messaging Services screen you can add a new service or edit an existing service. To 
add a new service, click on the New button. To edit an existing service, select the messaging service you 
wish to edit and then click on the Edit button. The Messaging Service Setup screen will open.

CONSULT YOUR MESSAGING SERVICE for their system’s connection method – dial-up or internet. 

 Dial-up (TAP) connection is also sometimes called a Access Number, Terminal Number, Modem 
Number, Alpha Port phone number, or Short Messaging Service phone number), optional system 
log-on password and for changes in any of the default communications parameters (Port Settings). 

 For Internet connections: SNPP & WCTP: Internet server address and port.

 For E-mail (SMTP): Consult your network administrator or ISP for Internet e-mail (SMTP) server 
address. Consult your Messaging Service for the e-mail address format of your wireless receiver 
for later entry of Receivers.
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The Messaging Service Setup screen allows you to edit or create messaging service entries in the database.

The following are the Messaging Service Setup fields:

Messaging service name: Enter the name of the messaging service.

Password: If the messaging service requires a password, enter it here (most services do not require a 
password). Note that if a password is entered into this field and it is not required or is incorrect, a 
communications error can occur while logging onto the wireless messaging service’s system.

Maximum Message Length: Enter the maximum number of characters that your wireless messaging 
service can accept for a text message if it is different from the default setting of 80 characters. If you 
exceed the wireless messaging service’s maximum message capability, your message will typically be 
either truncated and partially sent or not sent.

Log messages to this service: If you wish for a log to be kept of all messages sent to this service, select 
this checkbox. (See “Message Logging” on page 96 for more information.)

Note: Message logging can also be turned on for individual receivers in the Wireless Receiver setup (See 
“Manually Adding or Editing a Wireless Receiver” on page 57.)

Send messages via: There are five connection methods supported – Modem Dial-up (TAP) connection, 
Internet (SNPP), Internet E-mail (SMTP), Internet (WCTP), and Direct Connection (via leased line modem 
or serial connection). Check with your messaging service if you are unsure of the connection method to 
use. 

Note: Internet E-mail (SMTP) is not a direct connection to the Messaging Service. Internet E-mail 
(SMTP) utilizes the Internet E-mail routing system, and as such long delays could result. Do not use 
Internet E-mail (SMTP) for time critical messages.

Settings: The settings area of the dialog changes depending on the connection method chosen (Dial-up, 
SNPP, SMTP, WCTP or Direct Serial). See “Messaging Service Connection Settings” on page 49 for 
details on setting up each of the available connection methods.
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Messaging Service Connection Settings
Depending on the connection method chosen, the setup options listed in the settings area of the Messaging 
Services setup screen vary. Listed below are the setup options for each connection method:

Modem Dial-up  (TAP) Connection

Country: Select the proper country for this phone number.

Area Code: Enter the phone number’s area code.

Phone Number: Enter the messaging service phone number. Use of commas in the service phone number 
delays the dialing sequence by two seconds per comma. This is helpful for accessing an outside line in 
some telephone systems. Note that in most cases commas should be entered in your Windows Dialing 
Properties settings, and not in this field.

Use Area Code, Country Code, and Dialing Properties: If this checkbox is not selected, only the phone 
number will be dialed – the area code and country code will not be dialed. Use this only if you have a 
special dialing sequence that cannot be defined in the dialing properties.

Use Wizard: This button opens the "Add a Messaging Service" wizard.

Port Settings: This button allows you to change the communications properties for this connection. The 
default settings should work with most messaging services – change these settings only if you know that 
your messaging service requires special settings.
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Internet (SNPP) Connection

Server Address: Enter the Internet address of the SNPP wireless messaging server. (Example: 
snpp.alphatech.com)

Port Number: Enter the port number of the messaging server (usually 444).

Login ID: If your messaging service requires a login ID, enter the login ID here (usually the login ID is left 
blank).
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Internet E-mail (SMTP) Connection

E-mail Server and Port: Enter the e-mail server address and port used to send Internet e-mail. Check with 
your network administrator or your ISP for the correct setting. Typically the port number for SMTP is 25.

Server requires an SSL-secured connection: Check this option if your SMTP server requires an SSL-
secure connection. Enter the port number for your SMTP SSL connection, typically the port number for 
SMTP SSL is 465.

SMTP Authentication: Check this option if your outgoing mail server requires Authentication and enter 
the logon information.
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Internet (WCTP) Connection

Server address and Port number: Enter the Internet address of the WCTP wireless messaging server. 
(Examples: www.inforad.com/wctp; wctp.inforad.com; wctp.inforad.com/wctp)

DTD Address: If your WCTP Service requires a special DTD address, enter their DTD address. Most 
providers use the default provided.

Use Secure HTTP: Selecting this option will use Secure HTTP (SSL) for the connection to the WCTP 
Server. The Port number will change to 443 for HTTPS when selected and the Server address will use the 
“https://” designation on save.

WCTP Authentication: Most WCTP Services do not require Authentication. If your WCTP provider 
requires Authentication enter your logon information. (Note: Verizon Wireless Messaging requires 
Authentication, and you must first register at: 
http://wctp.myairmail.com/wctpRegistration/jsRegistration.jsp
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Direct Serial Connection

Direct serial connection through: Select the COM port that will be used for the direct serial or leased-line 
modem connection.

Port Settings: This button allows you to change the serial communications properties for this connection. 
The default settings should work with most messaging services – change these settings only if you know 
your messaging service requires special settings.
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The "Add a Messaging Service" Setup Wizard
The "Add a Messaging Service" Setup Wizard helps guide you through the process of setting up a dial-up 
modem connection to a new wireless messaging service. To set up an Internet connection to a messaging 
service, please refer to “Manually Adding or Editing a Messaging Service” on page 47.

To start the wizard, select "Messaging Service..." from the Edit menu to open the Messaging Services Setup 
screen, then click on the New button. When the Add Messaging Service dialog appears, click on the 
Wizard button. 

To begin using the wizard, click on the Next button.

1. You are first prompted to enter a name for the messaging service you wish to add. Enter the name 
of the messaging service company, and click on Next to continue.

2. You are then prompted to enter the phone number of the wireless messaging service’s system (also 
sometimes called a Access Number, Terminal Number, Modem Number, Alpha Port phone 
number, or Short Messaging Service phone number). Your modem connects with this number and 
then relays the wireless receiver numbers and associated text messages that you wish to send.

Enter the messaging service’s number. When you have entered a messaging service number, click 
on Next to continue.

3. Next, enter the maximum number of characters that your messaging service can accept for a text 
message if it is different from the default setting of 80 characters.

Note: If you exceed the messaging service’s maximum message capability, your message will 
typically be either truncated and partially sent or not sent.

4. Next, select the baud rate that is used by your wireless messaging service. Usually, this is either 
300, 1200, or 2400 baud. If you do not know the baud rate, use the default setting of 1200 baud. 
Click Next to continue.

5. The messaging service setup is complete. Click on Finish to add the new messaging service to the 
InfoRad Watch-IT messaging database or click on “Add another messaging service” if you wish to 
repeat the wizard.
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Building Your Wireless Receiver Directory
You should  have 
already set up at least 
one messaging service 
before entering new 
receivers. (See Building 
Your Wireless 
Messaging Services 
Directory for details.)

InfoRad Watch-IT provides for easy entry or changes in your wireless 
receiver directory. The directory allows you to setup as many receivers 
as you require, and each receiver name entered can be assigned to any 
previously programmed messaging service. The InfoRad Watch-IT 
alphabetical search feature will quickly zoom you in on a receiver to 
view/modify and will also help you select from your messaging service 
directory.

There are two receiver entry setup methods, the “Add a Receiver” setup 
wizard and the Wireless Messaging Receivers screen. To quickly add a 
new wireless receiver, you can use the “Add a Receiver” Setup Wizard. 
For more advanced receiver setup options, or to edit an existing receiver 
entry, use the Wireless Messaging Receivers screen.

To access either method, select “Receivers...” from the Edit menu. This will open the Wireless Messaging 
Receivers screen, which lists all defined wireless receiver numbers, who carries the receiver, and the 
appropriate messaging service.

From the Wireless Messaging Receivers screen you can add, modify, or delete wireless receiver 
information from the InfoRad Watch-IT receiver directory.
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Route on Failure option

The Route on Failure feature in InfoRad Watch-IT allows the addition of an Alternate Receiver or 
Alternate delivery method in the event of a failure when sending to the Primary Receiver. For example, if 
the Internet connection is down, the  message can be routed to the Dial-up TAP Service for delivery. 
Another option might be routing the message to an alternate Receiver different from the Primary Receiver, 
for example, route the pager message to the persons cell phone or PDA. The Alternate Receiver could even 
be a different persons wireless receiver, if desired.

Note that the program will use the Retries settings in Failed Message Retries in Preferences when 
attempting to deliver to the Primary receiver before rolling over to the Alternate Receiver to attempt 
delivery.

To utilize the Route on Failure feature for a Receiver, simply check the ‘Route to alternate receiver’ option, 
and enter the appropriate Receiver ID and Messaging Service for the Alternate Receiver.

Please note that Alternate delivery methods may have a different Receiver ID. For example, the Receiver 
ID when using an Internet service may require the 10-digit phone number, and the Dial-up service may 
require the 7-digit phone number; if the Primary delivery is e-mail the Receiver ID is the e-mail address, 
and the Alternate delivery may require the 7- or 10-digit phone number. 
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Manually Adding or Editing a Wireless Receiver

The Wireless Receiver Setup screen allows you to enter a new receiver’s information or edit the settings for 
an existing wireless receiver.

To access the Edit Wireless receiver screen, select "Receivers..." from the Edit menu or click on the 
Receivers button in the toolbar to display the Wireless Receivers Setup screen.

From this screen you can add or edit a wireless receiver’s settings, including the name of the person 
carrying the wireless receiver, the wireless receiver’s phone or PIN number or e-mail address, and the 
wireless messaging service used by the wireless receiver. You can also specify if wireless receiver 
messages sent to the wireless receiver will be logged or not, and whether to utilize the Route on Failure 
option to send failed messages to an Alternate Receiver. (See “Route on Failure option” on page 56  for 
more information.)
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Adding a New Wireless Receiver

1. When the Listing of Receivers screen appears, click on the New button.

2. Enter the person’s name carrying the wireless receiver.

3. Tab or click to the next line and fill in the wireless receiver number.

Note: For Wireless Receivers utilizing a ‘modem dial-up (TAP) connection, enter either the 
pager’s PIN number or phone number as required by your messaging service, but DO NOT
include the area code. (An exception for this rule would be if you are dialing in to a single, central 
TAP connection for a Messaging Service, versus individual TAP connections by city – then use 
the 10 digit phone number with area code.) 

If you are using internet paging (SNPP, WCTP, SMTP) use the 10-digit phone number (including 
the area code) or the PIN number of the Receiver.

For PCS phones enter the phone number including the area code.  

4. Click on the appropriate wireless messaging service. If you wish to add a new wireless messaging 
service, click on the Add button.

5. Optionally, you can enable message logging for this receiver.

Note: You can also select the message logging options when setting up your messaging service 
directory, to log all messages sent to a specific messaging service. (See “Building Your Wireless 
Messaging Services Directory” on page 46 for more information.)

6. Check the ‘Route to alternate receiver’ box if you wish to utilize the Route on Failure feature for 
this Receiver. Enter the Receiver ID and Messaging Service for the Alternate Receiver. (See 
“Route on Failure option” on page 56  for more information.)

7. When all the information is correct, click Ok.

Editing an Existing Wireless receiver

To view or edit information about a wireless receiver later, select Wireless receivers from the Edit menu.

1. Select the wireless receiver you wish to edit from the list and click on the Edit button or double-
click on the name. The system automatically displays the receiver information you entered earlier.

2. Tab down or click to any line and change the entry by typing over it or clicking the drop down to 
select the setting you want.

3. Click Ok to save your changes.
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The "Add Wireless Receiver" Setup Wizard
The "Add Wireless Receiver" Setup Wizard helps guide you through the process of adding a new wireless 
receiver to your messaging database.

To use the wizard, select "Receivers..." from the Edit menu or click on the Receivers button in the toolbar.

Click on the Add button to open the Wireless Receiver Setup screen, then click on the “Use Wizard” 
button.

1. You are first prompted to enter a name for the new wireless receiver. Enter a name and click on 
Next to continue.

2. You are then prompted for the receiver’s personal ID number (PIN) or wireless receiver number. 
Enter the wireless receiver number or PIN and click on Next to continue.

Note: For Wireless Receivers utilizing a ‘modem dial-up (TAP) connection, enter either the 
pager’s PIN number or phone number as required by your messaging service, but DO NOT
include the area code. (An exception for this rule would be if you are dialing in to a single, central 
TAP connection for a Messaging Service, versus individual TAP connections by city – then use 
the 10 digit phone number with area code.) .  

If you are using internet paging (SNPP, WCTP, SMTP) use the 10-digit phone number (including 
the area code) or the PIN number of the Receiver.

For PCS phones enter the phone number including the area code

3. Next, select the messaging service used by the receiver. If their messaging service is not listed, 
you can click on the "Add…" button to start the "Add a Messaging Service" wizard and enter their 
messaging service into the database. When you have selected the receiver's messaging service, 
click on Next to continue.

4. The new receiver setup is complete. If you wish to add another receiver, click on the “Add another 
receiver” button. Click on Finish if you are done using the Add Wireless Receiver wizard.

Note: If you later wish to edit this receiver's settings or add an Alternate Receiver for Route on 
Failure, you can use the Wireless Receiver Setup screen to make modifications (See “Editing an 
Existing Wireless receiver” on page 58 for details).
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Building Your Group Directory (Optional)
Wireless receivers can be grouped together so you can send messages to a number of people 
simultaneously. When a group is messaged, InfoRad Watch-IT automatically sorts and combines all 
messages in the messaging dispatch queue according to their messaging service. This eliminates redialing 
and speeds up the messaging process when you have a large number of people to send messages.

To create a messaging group, select “Groups...” from the Edit menu. The Listing of Groups screen appears.

The Listing of Groups screen lists all of the defined messaging groups. From this screen you can add a new 
group or modify an existing group.
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Adding a New Group
1. From the Listing of Groups screen, click the New button.

2. Enter a name for the new group.

3. To add a receiver, select that receiver from the “Available receivers” column and press “<< Add”.

4. To remove a receiver, select the receiver in the “Group Members” column and press “Remove 
>>”.

5. Repeat as needed to add additional receivers. When you are finished adding receivers to the group, 
click on Ok.

Note: InfoRad Watch-ITallows up to 500 Group members.

Modifying a Group
1. From the Listing of Groups screen, select the messaging group you want to modify and select the 

Edit button.

2. To add a receiver, select that receiver from the “Available receivers” column and press “<< Add”.

3. To remove a receiver, select the receiver in the “Group Members” column and press “Remove 
>>”.

4. When you are finished adding or removing receivers to the group, click on Ok to save the changes 
to the group.

Note: InfoRad Watch-ITallows up to 500 Group members.

Receiver Group Assignment Query
From the main screen Receiver/Group list a Receivers’ Group assigment(s) can be viewed by hovering the 
mouse pointer over or selecting a Receiver name and then clicking the mouse right-button. A listing of  the 
selected Receivers’ Group assignments will be displayed. The ‘Edit Groups’ setup dialog can be accessed 
from the list to change Group assignments by clicking on the ‘Edit Groups’ button in the assingment list 
dialog.





InfoRad Watch-IT Automated Messaging  63

Automated Messaging

Automated Messaging Overview
Watch-IT is designed to automatically process “message files” created by a user, another application, or a 
batch process. These message files contain all of the messaging information necessary for Watch-IT to
automatically create a wireless receiver message and send it to the desired individual or group.

Watch-IT ASCII monitors a specific directory for message files, while Watch-IT Serial monitors a 
communications port for records containing an “alarm code” which triggers message processing of the 
record containing the code.

For details how each version of Watch-IT handles automated messaging, please refer to the following 
sections:

 “Watch-IT ASCII and ASCII SV Message Processing” on page 64

 “Watch-IT Serial Message Processing” on page 80

For general details on using Watch-IT ASCII SV, please refer to the following section:

 “Watch-IT ASCII SV General Operation” on page 76
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Watch-IT ASCII and ASCII SV Message Processing
Note: This section covers Watch-IT ASCII and Watch-IT ASCII SV. For details on how Watch-IT 
Serial processes automated messages, please refer to “Watch-IT Serial Message Processing” on 
page 80.

Watch-IT ASCII and ASCII SV are designed to automatically process “message files” created by 
a user or generated by a custom application or batch process. These message files contain all of the 
messaging information necessary for Watch-IT ASCII to create a wireless message and send it to 
the desired receiver. Watch-IT ASCII monitors a specified file directory for message files.

For details on configuring how Watch-IT ASCII processes message files, please see “Watch-IT 
ASCII and SV Setup” on page 31. 

The following is the normal sequence of events during Watch-IT ASCII message processing:

1. A message file is created and saved in the Watch-IT message directory. This file can be 
manually created by a user or automatically generated by a program, batch file, or 
process.

2. Watch-IT checks the message directory at a predetermined time interval, looking for files 
which match the expected filename format. (See “Message Filename Setup” on page 35
for details on filename setup.)

3. If the program finds a file which matches the correct filename format, Watch-IT opens 
the message file and processes the information inside to generate and send a wireless 
receiver message.

4. After a message file has been processed, Watch-IT optionally creates message status 
files, indicating whether the message was successfully sent or if there was an error in 
processing the file. (See “Message Status Files” on page 73 for details on using message 
status files.)
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Message File Formats and Conventions
Message files are special ASCII text files that are formatted in a specific manner for automated processing. 
This section details the message file format, and includes some notes on developing custom messaging 
applications that can take advantage of this format.

A program (third party client) that wishes to send pages through the Watch-IT ASCII / SV service must 
adhere to the file naming convention and it is suggested to use a unique client number.

If multiple third party clients are to be used, it is optional (suggested) and up to the System Administrator 
to assign unique client numbers to each of those programs to ensure there will be no conflict.

Message File Format

A wireless receiver message file is an ASCII text document that can contain any number of messages to 
individuals or groups. The beginning of each wireless receiver message in the message file is marked by a 
single line with “MSG:”, followed by between two and five of the following components:

Part Description Required?

FROM: Who the message is from. Optional

TO: Who the message is to be sent to. Mandatory

DATE: Date the message was created. Optional

REPLYTO: Reply address. SMTP & WCTP only. Optional

CONTENTS: The actual message text. Mandatory

Message files are formatted in a specific manner for automated processing. This section details the message 
file format, and includes some notes on developing custom messaging applications that can take advantage 
of this format. Note that multiple messages can be included in a single message file.

Sample Message File 

MSG:
TO: George Brown
FROM: Server 128
CONTENTS: Power has failed, server 128 is now running on UPC power. 
(Automated Message)

MSG:
TO: 555-1212 1-800-555-8081
FROM: Dispatch Central
CONTENTS: Proceed to I90&E.185th. Multi-car accident.
** This is a comment line. It is not sent. **
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Message Delimiters

The following are the default delimiters used to mark the different parts of a wireless receiver message file. 
(See “Message Delimiters Setup” on page 38 for details on customizing these delimiters.)

MSG: Marks the beginning of a new wireless receiver message. This 
delimiter must be on a line by itself.

FROM: Indicates who the message is from. Inclusion is optional.

TO: Destination delimiter text. This is a programmed “User” or 
“Group” name from the Watch-IT directory files. (See 
“Manual Messaging in Message Files” on page 68 for TO: 
field formats without programmed directory files.)

DATE: Optional Date/Time Stamp delimiter text. Note: Many 
messaging services automatically “stamp” each message. A 
Date/Time Stamp requires 8-15 characters and will reduce 
your maximum message length by that amount.

CONTENTS: The message contents delimiter text. The message contents 
can be multiple lines of text.

REPLYTO: ‘Reply To’ address for SMTP & WCTP messages. Inclusion 
is oprtional.

** The comment delimiter text. Comments are not transmitted 
with the message. Comments must begin and end with the 
comment delimiter.

Message File Conventions

Each message in the wireless receiver message file must be preceded by the delimiter “MSG:”. This 
delimiter marks the beginning of a new wireless receiver message and must be the first element in any 
wireless receiver message.

The FROM:, TO:, and CONTENTS: sections may be in any order within the file but must contain the exact 
delimiter text followed by one blank (space) character.

Any text preceded by two asterisks (**) and a blank and followed by a blank and two asterisks is 
considered informational only and is not scanned as part of the page message information. This allows you 
to insert comments or additional notes into the message file that you do not wish to send as messaging data.

Note: Multiple messages can be entered in one message file.
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Standard Messaging in Message Files
A standard sample Message File:

MSG:

TO: George Brown

FROM: Server 128

CONTENTS: Power has failed, server 128 is now running on UPC power. 

The most common type of Watch-IT ASCII and ASCII SV operation utilizes the Watch-IT database for 
programming the Receivers and Messaging Serivices. The Message File then need only contain the 
Receiver name in the TO: field of the Message File. Upon processing the Messsage File, Watch-IT looks 
up the Receiver Name in the TO: field to find the ReceiverID / Address and the Messaging Service 
information to complete processing and sending of the Message File. For information on Message File 
formats utilizing external data for Wireless Receivers and Messaging Services see “Manual Messaging in 
Message Files” on page 68.
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Manual Messaging in Message Files
Note: Manual messaging is supported only in the full versions of Watch-IT ASCII and ASCII SV. It is not 
supported in Watch-IT ASCII-75.

Also note that the Route on Failure feature cannot be utilized when using Manual Messaging in Message 
Files. To use the Route on Failure feature see “Standard Messaging in Message Files”.

Watch-IT allows you to enter a wireless receiver and messaging service name, number or address  in place 
of a name in the “TO:” field. 

‘Manual Messaging’ in message files allows you to message someone who has not been entered into the 
Watch-IT messaging directory/database, or use messaging information stored elsewhere (such as in a 
custom database or form).

Manual ‘Modem Dial-Up (TAP)’ Message Files

To enter a manual messaging number, you need to enter the wireless receiver number of the person you 
wish to page first, then a space, and then the number or the name of the person’s messaging service.

Note: You do not need to enter dashes in the phone number, and spaces are not allowed. For example, 555-
1212 may be entered as either “555-1212” or “5551212”, but not “555 1212”. Also note that you can enter 
either the messaging service number or the name of the messaging service (if you have already defined the 
messaging service information). “The "Add a Messaging Service" Setup Wizard” on page 54 can be used to 
define a ‘modem dial-up(TAP)’ messaging service.

Example:

MSG:
TO: 555-1212 1-800-555-8081
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service at 1-800-555-8081, which in turn will transmit the message to wireless receiver number 555-1212.

MSG:
TO: 555-1212 PagerCentral
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service PagerCentral, which in turn will transmit the message to wireless receiver number 555-1212.

MSG:
TO: 555-1212 tap://18005558081
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service at 1-800-555-8081, which in turn will transmit the message to wireless receiver number 555-1212.
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Manual Message Files for Internet Messaging

You can send manual messages to Internet services by including in the TO: field of a Message File the 10-
digit Receiver phone number or Receiver PIN number followed by a space, and then one of the following 
protocol identifiers followed by the Messaging Service address. Optionally, the Mesaging Service address 
can be followed by the Port number.

wctp://  identifies a WCTP Messaging Service address

http://  identifies a WCTP Messaging Service address

snpp:// identifies a SNPP Messaging Service address

smtp:// identifies a SMTP(E-mail) address

WCTP Examples:

TO: 2165551212 wctp://wctp.sample.com /wctp

or

TO: 2165551212 http://wctp.sample.com/wctp

SNPP Example:

TO: 2165551212 snpp://snpp.sample.com:7777

SMTP Example:

TO: 1234567@mypager.com smtp://smtp.sample.com

Also, for the Internet address you can use the IP address (for all the Internet protocols). For example :

TO: 2165551212 snpp://25.356.458.123
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Manual ‘Internet (WCTP)’ Message Files

To enter a manual messaging number, you need to enter the wireless receiver number of the person you 
wish to page first, then a space, and then the name or address of the Receiver’s messaging service.

Note: You do not need to enter dashes in the phone number / ReceiverID number, and spaces are not
allowed. For example, 216-555-1212 may be entered as either “216-555-1212” or “2165551212”, but not 
“216 555 1212”. Also note that you can enter either the WCTP address (and optionally the Port number) of 
the messaging service or the name of the messaging service (if you have already defined the messaging 
service information). “Manually Adding or Editing a Messaging Service” on page 47 can be used to define 
an ‘internet(WCTP)’ messaging service.

Example:

MSG:
TO: 2165551212 PagerCentral
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service PagerCentral, which in this example is defined in the Messaging Service Directory as an Internet 
WCTP service, which in turn will transmit the message to wireless receiver number 216-555-1212.

MSG:
TO: 2165551212 wctp://wctp.sample.com/wctp
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service at Internet address wctp.sample.com on Port 80 via the WCTP protocol, which in turn will transmit 
the message to wireless receiver number 216-555-1212. When no Port assignment follows the WCTP 
address, Port 80 is assumed.

MSG:
TO: 2165551212 wctp://wctp.sample.com/wctp:80
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service at Internet address wctp.sample.com on Port 80 via the WCTP protocol, which in turn will transmit 
the message to wireless receiver number 216-555-1212.

MSG:
TO: 1234567 http://www.sample.com/wctp
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

For a WCTP service you can also use the “http://” address of the messaging service. In the example 
message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging service at Internet 
address www.sample.com/wctp on Port 80 via the WCTP protocol, which in turn will transmit the message 
to wireless receiver PIN number 1234567.

MSG:
TO: 1234567 wctp://123.25.456.78/wctp
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service at Internet address 125.25.456.78 on Port 80 via the WCTP protocol, which in turn will transmit the 
message to wireless receiver PIN number 1234567.
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Manual ‘Internet (SNPP)’ Message Files

To enter a manual messaging number, you need to enter the wireless receiver number of the person you 
wish to page first, then a space, and then the name or address of the Receiver’s messaging service.

Note: You do not need to enter dashes in the phone number / ReceiverID number, and spaces are not
allowed. For example, 216-555-1212 may be entered as either “216-555-1212” or “2165551212”, but not 
“216 555 1212”. Also note that you can enter either the SNPP address (and optionally the Port number) of 
the messaging service or the name of the messaging service (if you have already defined the messaging 
service information). “Manually Adding or Editing a Messaging Service” on page 47 can be used to define 
an ‘internet(SNPP)’ messaging service.

Example:

MSG:
TO: 2165551212 PagerCentral
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service PagerCentral, which in this example is defined in the Messaging Service Directory as an Internet 
SNPP service, which in turn will transmit the message to wireless receiver number 216-555-1212.

MSG:
TO: 2165551212 snpp://snpp.sample.com
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / WV will send the wireless receiver message to the messaging 
service at snpp.sample.com/wctp on Port 444 via the SNPP protocol, which in turn will transmit the 
message to wireless receiver number 216-555-1212. When no Port assignment follows the SNPP address, 
Port 444 is assumed.

MSG:
TO: 2165551212 snpp://snpp.sample.com:7777
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service at Internet address snpp.sample.com on Port 7777 via the SNPP protocol, which in turn will 
transmit the message to wireless receiver number 216-555-1212.

MSG:
TO: 1234567 snpp://123.25.456.78
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service at Internet address 125.25.456.78 on Port 444 via the SNPP protocol, which in turn will transmit the 
message to wireless receiver PIN number 1234567.
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Manual ‘Internet E-mail (SMTP)’  Message Files

To enter a manual messaging number, you need to enter the wireless receiver e-mail address of the person 
you wish to page first, then a space, and then the name or address of the Receiver’s messaging service.

Note: Do not enter dashes in the phone number / ReceiverID number portion of the Wireless Receiver’s e-
mail address, and spaces are not allowed. For example, Wireless Receiver 216-555-1212 must be entered 
as “2165551212@mypager.com”, not “216 555 1212@mypager.com”. Also note that you can enter either 
the SMTP address (and optionally the Port number) of the messaging service or the name of the messaging 
service (if you have already defined the messaging service information). “Manually Adding or Editing a 
Messaging Service” on page 47 can be used to define an ‘internet e-mail(SMTP)’ messaging service.

Example:

MSG:
TO: 2165551212@mypager.com MyISPEmail
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the messaging 
service MyISPEmail, which in this example is defined in the Messaging Service Directory as an Internet 
SMTP service, which in turn will relay the message to the Messaging Service’s Internet e-mail server, 
which will process the message into the wireless network and to wireless receiver number 216-555-1212.

MSG:
TO: 2165551212@mypager.com smtp://smtp.sample.com
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the e-mail server 
at smtp.sample.com on Port 25 via the SMTP protocol, which in turn will relay the message to the 
Messaging Service’s Internet e-mail server, which will process the message into the wireless network and 
to wireless receiver number 216-555-1212. When no Port assignment follows the SMTP address, Port 25 is 
assumed.

MSG:
TO: 2165551212@mypager.com smtp://smtp.sample.com:25
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the e-mail server 
at Internet address smtp.sample.com on Port 25 via the SMTP protocol, which in turn will relay the 
message to the Messaging Service’s Internet e-mail server, which will process the message into the 
wireless network and to wireless receiver number 216-555-1212.

MSG:
TO: 1234567@mypager.com SMTP://123.25.456.78
FROM: FRANK WEILER
CONTENTS: Tom, page me when you get a chance.

In the example message, Watch-IT ASCII / SV will send the wireless receiver message to the e-mail server 
at Internet address 125.25.456.78 on Port 25 via the SMTP protocol, which in turn will relay the message to 
the Messaging Service’s Internet e-mail server, which will process the message into the wireless network 
and to wireless receiver number 1234567.
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Message Status Files
Status files are created during message file processing, and can be used to track the progress of Watch-IT 
ASCII / SV message processing. There are two conventions used for naming message status files, “old-
style” and “new-style.”

The ASCII File conventions of Watch-IT ASCII, AlphaPage Windows AFP, and AlphaPage DOS AFP are 
referred to as the “old-style scheme.” Watch-IT ASCII SV also supports a new ASCII File convention 
known  as  “new-style scheme.”

The ASCII File Options dialog in Watch-IT ASCII SV allows setup of either or both schemes. The Watch-
IT ASCII SV supports both schemes for backward compatibility. Watch-IT ASCII SV can support either 
scheme independently or simultaneously.

“Old-style” and “new-style” use different initial / default settings of File Names and Status File Names. 
The “new-style” utilizes a client ID in the “new-style” message file names (the use of a client ID is optional 
for your application – you may name the files as you desire, even use the “old-style” filenames in the “new-
style” settings).

If you are using Watch-IT ASCII, please refer to “

Old-Style Status Files (Watch-IT ASCII and ASCII SV)” on page 75.

If you are using Watch-IT ASCII SV, also refer to “New-Style Status Files (Watch-IT ASCII SV Only)” on 
page 74.
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New-Style Status Files (Watch-IT ASCII SV Only)

InfoRad Watch-IT ASCII SV utilizes three different message status text files during and after processing a 
message file in addition to the original input message file. Below are the files created using the initial / 
default filenames – these filenames can be changed in the ASCII File Setup (Watch-IT ASCII in the Setup 
Menu; Watch-IT ASCII SV Service Controller in the Edit Menu).

Service Input File

The Watch-IT ASCII SV Service looks for files with this filename, and attempts to parse them. 
This is the filename created by the clients when first generating a message file:
MESSAGE__(client number).(message ID)

Service output: processing

The Watch-IT ASCII SV Service creates a file with this name to let the clients know that it has 
seen and parsed the corresponding input file.  The system erases the input file:
MESSAGE__(client number).(message ID) and creates a new file to indicate the file is 
being processed:  PROCESS__(client number).(message ID)

Service output: sent

The Watch-IT ASCII SV Service creates a file with this name to indicate that the messages in the 
corresponding input file have been sent successfully:
SENT_MSG_(client number).(message ID)

Service output: failed

The Watch-IT ASCII SV Service creates a file with this name to indicate that the messages in the 
corresponding input file have not been sent. This file contains information on why the message or 
messages failed:
ERR_MSG__(client number).(message ID)

NOTE: The custom application that generates the message files must be responsible for removing the 
generated status files once the message status has been reported as Sent or Error by the creation of the 
appropriate status file (PROCESS__(client number).(message ID)  and either (SENT_MSG_(client 
number).(message ID) or ERR_MSG__(client number).(message ID).
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New-Style Status Filename Format

Those who are familiar with the old system may find it helpful to compare the filenames used in the old 
and new systems:

File Type Old Style System New Style System

Service input PAGEMSG.(message ID) MESSAGE__(client 
number).(message ID)

Service output: 
processing

PAGEMSGI.(message ID) PROCESS__(client 
number).(message ID)

Service output: 
sent

PAGEMSGS.(message ID) SENT_MSG_(client 
number).(message ID)

Service output: 
failed

PAGEMSGE.(message ID) ERR_MSG__(client 
number).(message ID)

(message ID)

In the old system, this was a 3 character base-36 number. This number was kept on a global basis, meaning 
all of the client programs had to share the same space of 46,000 numbers (and thus 46,000 filenames) the 
system allowed.

In the current system, message IDs are 8 character hexadecimal numbers. Because a client number is 
included (see below) and because the message IDs are kept by the client programs, not globally, each client 
has about 4 billion possible filenames it can use to generate message files.

(client number)

Every file in the current system also contains a client number (utilizing the default / initial settings). This 
ensures that no two clients will ever attempt to use the same filename. The system administrator assigns the 
client numbers to the third party clients. Use of a client number in the filename format is optional.

Old-Style Status Files (Watch-IT ASCII and ASCII SV)

If the “Create Status files” option is selected in the ASCII File Setup dialog, Watch-IT will create several 
different text files after sending a wireless receiver message.

There are three types of status files created by Watch-IT:

Input Files: This is just the message file with a new name. The filename is changed to prevent the 
AFP from attempting to send the messages in it again. The system that created the message file 
can remove this file or use it for whatever purpose it chooses.

Sent Files: This file contains the recipient name, the messaging service used, the exact message text 
sent to the wireless receiver, and the date and time that the page was sent. This can be useful if the 
system needs to keep track of what pages were sent when. This file is only created if the page was 
sent successfully, so it’s presence is an indicator that the page was sent.

Error Files: This file is only created if there is a problem sending a page. This file contains the same 
information as the Sent File, plus an error message to help diagnose the problem.

The filenames for each of these types of status files is user-definable. For details on customizing the 
filename for the message status files, please refer to “Status Files Filename Setup” on page 36.
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Watch-IT ASCII SV General Operation
Note: Watch-IT ASCII SV is a version of InfoRad Watch-IT ASCII optimized for use on Windows® 2000 
and greater. While it provides all of the functionality of InfoRad Watch-IT ASCII, the main application has 
been split into two separate programs: a messaging “engine,” which has been transformed from an 
application into a Windows Service, and a Service Controller application which acts as an administrative 
interface for managing the messaging engine.

This change also affects certain portions of the program interface. This section covers the differences in 
Watch-IT ASCII SV program operation from the non-SV version.

There are two separate software modules Watch-IT ASCII SV:

Watch-IT ASCII SV 
Service Module

This is the background messaging “engine.” There is 
no direct user interaction possible with this module –
configuration is done through the Service Controller 
module. The services module only runs on the 
computer designated as the Messaging Server.

Watch-IT ASCII SV 
Service Controller

The Services Controller is an administrative module 
for configuring and maintaining the Watch-IT ASCII 
SV Services messaging engine. This module can be 
run from the messaging server PC or remotely from 
any other PC on the network.



InfoRad Watch-IT Automated Messaging  77

Watch-IT ASCII SV Service Controller
To configure or modify Watch-IT ASCII SV settings, you need to use the Watch-IT ASCII SV Service 
Controller, which is available from the Windows Start>Programs menu.

From the Service Controller you can start or stop the Watch-IT ASCII SV messaging service, run the 
service from another computer on the network, or configure Watch-IT ASCII SV.

The original Watch-IT ASCII program accesses all setup and configuration options from the Setup menu. 
In the Watch-IT ASCII SV Service Controller, these setup options are accessed from the Edit menu.

Once you have configured the Watch-IT ASCII SV settings, you can close the Service Controller. The 
Watch-IT ASCII SV services do not require the service controller to be running.

Note: While the Service Controller can be run remotely from any computer on the network, the 
Communications Setup can only be run directly on the computer that has been setup as the messaging 
server.
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Watch-IT ASCII SV Setup and Configuration

All configuration and setup of Watch-IT ASCII SV is done through the Service Controller. Setup options 
are accessed through the Edit menu, instead of the Setup menu (as in Watch-IT ASCII and Watch-IT 
Serial).

From the Edit menu you can add or change the messaging databases, including messaging services, 
receivers, and receiver groups. You can also change the program preferences, communication settings, and 
the ASCII message settings.

For details on each of these setup options, please refer to the following sections:

 “Communications Setup“ on page 18

 “Preference Options” on page 26

 “ASCII File Setup” on page 33

 “Manually Adding or Editing a Messaging Service” on page 47

 “Manually Adding or Editing a Wireless Receiver” on page 57

 “Adding a New Group” on page 61

Note: While the Service Controller can be run remotely from any computer on the network, the 
communications setup procedure can only be run directly on the computer that has been setup as the 
messaging server. All other setup options can be run from any computer.
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Watch-IT ASCII SV Service Module
The Watch-IT ASCII SV Service module is a background messaging “engine.” There is no direct user 
interaction possible with this module – configuration is done through the Service Controller. The Service 
module only runs on the computer designated as the messaging server. When installed, the Service module 
is listed in the Service control panel of the computer where it was installed.

To configure the Service module, select “Connect to Service” from the File menu of the Service Controller. 
You will be prompted to select whether you wish to connect to the service on this computer or on another 
computer.

If you are currently on the computer designated as the messaging server, select “Service on this computer:” 
If you are running the Service Controller on another computer on the network, select “Service on a remote 
computer” and enter the name of the messaging server computer.

You can also start or stop the Watch-IT ASCII SV service from the Service Controller. The “Service 
Status” portion of the main screen lists the current status of the service module.

To Start or Stop the service, select the “Start service” or “Stop service” buttons as appropriate. The “Update 
Status” button can be used to update the current Service Status display.
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Watch-IT Serial Message Processing
Note: This section covers Watch-IT Serial. For details on how Watch-IT ASCII processes automated 
messages, please refer to “Watch-IT ASCII and ASCII SV Message Processing” on page 64.

Watch-IT Serial does not use “message files,” but instead monitors a communications port for records 
containing an “alarm code” which then triggers message processing of the record containing the code.

There are two step areas needed to set up Watch-IT Serial to monitor and process messaging information:

 Serial Monitoring Setup

 Serial Alarm Code Mapping

The Serial Monitoring Setup screen allows you to configure how Watch-IT Serial will monitor for 
records to process. The Serial Monitoring Setup dialog is automatically opened during the installation 
process, and can also be accessed from the Setup menu.

The Serial Alarm Code Mapping screen allows you to specify the codes which will cause Watch-IT 
Serial to generate a wireless message, and which receivers will receive the message for each alarm 
code.

Once you have configured the serial monitoring options and defined the alarm codes, Watch-IT Serial is 
ready for operation.

To begin using Watch-IT Serial, select “Start Serial Monitoring” from the Setup menu. Watch-IT Serial 
will begin monitoring the specified serial port for records containing one of the specified alarm codes.

The following is the normal sequence of events during Watch-IT message processing:

1. A record is sent to the comm port being monitored. This record can be manually created by a user or 
automatically generated by a program, batch file, or process.

2. Watch-IT monitors the comm port, looking for records which contain one of the predefined “alarm 
codes”.

3. If the program finds a record which contains an alarm code, Watch-IT opens the record and processes 
the information inside according to the preset criteria to generate and send a wireless receiver message.

4. After a record has been processed, Watch-IT creates a wireless message and sends it to the appropriate 
wireless receivers.

Note: For details on setting up alarm codes, including message criteria and assigning recipients or 
groups, see “Serial Alarm Code Mapping” on page 42.
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Sending Wireless Messages

Wireless Messaging Overview
Note: Sending wireless receiver messages directly from within the Watch-IT application is not 
supported in Watch-IT ASCII SV. If you are using Watch-IT ASCII SV, please disregard this 
section.

Sending wireless receiver messages directly from within Watch-IT (called “Console Messaging”) 
is possible from the Watch-IT ASCII and Watch-IT Serial versions once you have built your User, 
Group, and Messaging Service directories. The directory search feature can quickly assist you 
with your selections.

There are two main methods of messaging:

 Sending Messages by Name or Group

 Sending Messages By Receiver Number

In addition, there are several options available with each of these messaging methods, such as 
scheduled messages and predefined messages. For details on messaging options, please refer to 
“Message Options” on page 84.

Note: Automatic ASCII or serial messaging is halted while entering a console message. ASCII 
and serial messages will continue to queue, however, but will not be sent until the console 
message has been entered.

Also, please note that the time and date stamping feature is only available from automated 
processing, and cannot be used when using console messaging.
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Sending Messages by Name or Group
1. In the “Select message recipients” window, click on the name of the person or group you wish to 

send a message to or type in the first few letters of the name.

Groups have a group icon  displayed next to the group name in the receivers list.

(If you have not set up any receivers yet, please see “Building Your Wireless Messaging 
Directories” on page 45.)

To choose a different name, just use the arrow keys or click on the new name to select it.

Note: You can message more than one person or group at a time (creating a temporary or “ad-
hoc” group) by selecting multiple names from the list. To select more than one name, hold down 
the Control (or Ctrl) key when clicking on additional names. Also, the Shift key can be held down 
to select a range of names (from the currently selected name to where you click).

2. Once you have selected the recipients, press Tab to move to the “Type message” window to begin 
typing your message. The message you enter will be sent to all selected individuals and groups. (If 
you plan on often sending messages to the same group of individuals, you should set up a 
messaging group. See “Building Your Group Directory (Optional)” on page 60 for more 
information.).

A character and number of pages counters are visible above the message entry area. Messages can 
be up to 1024 characters long and can be optionally auto-split into several pages depending on the 
capacity of the messaging service and receiver you are using. To correct typing mistakes, use the 
Delete or Backspace keys to type over existing text. Also, you can use your mouse to move around 
within your message.

Note: You can also enter messages from other documents using Windows copy (Ctrl+C) and paste 
(Ctrl+V) functions. Just copy the desired text, and paste it into the message input screen.

3. When your message is complete, click on the Send button to send the message. When Send is 
selected, Watch-IT will inform you of its progress in sending your message. Optionally, you can 
queue the message for batch sending, or schedule when the message will be sent (See “Message 
Queue” on page 95 and “Scheduled Messages” on page 89 for details).
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Sending Messages By Receiver Number
Watch-IT allows you to send messages manually, without first defining a receiver. This is useful for one-
time messaging needs, when you do not wish to add the receiver number to your directory.

1. Enter the message you wish to send or use the Options menu pull down to select the previous 
message and other options. A character counter is visible above the message entry area. Messages 
can be up to 1024 characters long and can be optionally auto-split depending on the capacity of 
your messaging service and the receiver you are using. (See “Preference Options” on page 26 for 
more information.)

2. Click on the Options button under the type message window, then select “Send to unlisted 
receiver.” The Send to Unlisted Receiver screen will appear.

3. Enter the ID number of the receiver you wish to send to.

Note: For PCS phones enter the phone number including the area code. For text pagers, enter 
either the pager’s PIN number or phone number as required by your messaging service, but DO 
NOT include the area code, unless you are using internet paging, which may require a 10-digit 
pager phone number (including the area code) or PIN number.

4. Click on the drop down box and select a messaging service, or enter the messaging service phone 
number. Click on Ok.

5. When your message is complete, press Enter or click on the Ok button to send the message. 
Watch-IT will inform you of its progress in sending your message.
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Message Options
Watch-IT offers you several different options for text message input, including the following:

 Signature

 Predefined Messages

 Previous Message (Last Message Recall)

 Template Messages

 Scheduled Messages

 Queue Message (See « Message Queue” on page 95)

 Send to unlisted receiver (See “Sending Messages By Receiver Number” on page 83 )

These options are available by selecting them from the Options button drop-down menu.
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Signature
If you wish to include your message signature with a message, click on the Options button below the 
message entry area, select Signature, and then select whether you’d like the signature placed before or after 
the message.

If either of these options is selected, your signature message will automatically be included with each 
message you send.

Note: Your message signature will not be displayed while you enter your message, but will be included 
with the message when it is sent.

(See “Preference Options” on page 26 for details on setting up a message signature). If you include your 
message signature, the character count for the message will include the number of characters in your 
signature.

Predefined Messages
Watch-IT allows you to define up tp 500 common messages into a custom list that can be easily accessed 
from the message input screen. To view or create a predefined message, click on the Options button under 
the message input window and then select the Predefined Message menu.

To send a predefined message, select the message you wish to send from the Predefined message menu. 
The message text is entered into the message input window, where it can then be modified and sent as an 
ordinary wireless receiver message.

To create a new predefined message or edit an existing predefined message, select “Edit predefined 
messages” from the Predefined message menu.

The Predefined Messages dialog will appear.
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The Predefined Messages dialog allows you to add, edit, or delete custom messages. The list of predefined 
messages can be listed alphabetically, or by the number of times each message has been used.

 To create a new predefined message, click on the Add button, then type in the new message you 
wish to save.

 To edit a message, first highlight the message you wish to modify and then click on the Edit 
button.

 To delete a message, click on the message you wish to delete and then click on the Delete button.
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Previous Message (Last Message Recall)
You may want to repeat your last message entered, either to the same recipient or to someone else. Watch-
IT allows you to access any of the last 10 messages sent.

To send a previous message, first select the Wireless receiver Name or Group that you want to send the 
message to.

To recall the text of a previous message, click on the Options button and then select the Previous Message 
menu.

A list of previous messages will be displayed. If you wish to delete all previous messages from the recall 
menu, select the “Clear list” option.

Select the desired previous message from the list. The message is entered into the message input window, 
where it can now be edited as needed for the new message.

When the new message is correct, click on the Send button to send your message.
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Template Messages
InfoRad Watch-IT allows you create and utilize Template Messages. Template messages are predefined 
messages with entry fields for the sender. For example, a job dispatch template. InfoRad Watch-IT installs 
several sample templates as examples. Please see Addendum T for instruction on creating and using 
Template Messages. 

To use a template for messaging, select the Receiver(s) or Group(s) to receive the message, then on the 
Options menu select ‘Template message’.

A listing of available templates will be displayed. Select the template you wish to use from the list.

The selected template will be displayed. An example is shown below.

Enter the required information into the template fields. Then select the ‘Send’ button to send the message 
immediately, or select the ‘Schedule’ button to schedule the message for sending later.
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Scheduled Messages
Watch-IT allows you to specify up to 500 messages to be sent at a specific time and date, if necessary.  
This allows you to send messages as meeting or appointment reminders. If you have entered your own 
receiver information into Watch-IT, you can even send yourself scheduled reminders. 

To schedule a message, simply create a message as you normally would, then click on the Options button 
under the message input window and select the “Schedule message…” option from the Options menu to 
bring up the Scheduled Message dialog.

From this dialog you can set the time and date that you would like the wireless receiver message to be sent.

Once you have selected a date and time to send your message, click on the Ok button to place your message 
in the scheduled messages queue. The scheduled messages queue can be viewed by selecting Scheduled 
Messages from the List menu.

Note: Watch-IT will warn you if there are any scheduled messages pending when you try to exit the 
program. Watch-IT cannot send a scheduled message if the program is not running at the specified 
date and time. If the software is not running when a message is scheduled to go out, the message will be 
processed  the next time Watch-IT is started according to the “Scheduled Messages option” in “Preference 
Options” on page 26.
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Recurring Scheduled Messages
InfoRad Watch-IT includes an Advanced Scheduler allowing for Recurring Scheduled Messages. Messages 
can be set to recur on a Daily, Weekly, or Monthly schedule.  

To schedule a Recurring Message, simply create a message as you normally would, then click on the 
Options button under the message input window and select the “Schedule message…” option from the 
Options menu to bring up the Scheduled Message dialog, then select one of the Advanced Schedule 
Options (Daily, Weekly, Monthly) from the ‘Message will be sent’ option drop down.
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Daily options:

Every xx day(s): Select how many days (1-365) between sending the message.  
Example: Choose 1 day for every day. Choose 365 days for once a year.

Start Date: Select the date the scheduled message should begin being sent.

End Date: Select the last day the scheduled message should be sent. If no end date is selected, the message 
will continue as scheduled until deleted from the Scheduled Messages list.

Weekly options:

Every xx weeks(s): Select how many weeks (1-52) between sending the message.  
Example: Choose 1 week for every week. Choose 26 weeks for twice a year.

Days of the Week: Select the day(s) of the week to send the message.                                       Example: 
The message can be sent  one day a week, several days a week, weekdays only, or weekends only.

Start Date: Select the date the scheduled message should begin being sent.

End Date: Select the last day the scheduled message should be sent. If no end date is selected, the message 
will continue as scheduled until deleted from the Scheduled Messages list. Note that the end date will be 
adjusted automatically when the schedule is saved according to the last time the message can be sent under 
the selected schedule.
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Monthly options:

Day of the month: Select the day of the month (1-31) between sending the message.  
Note: If the day of the month selected is greater than the 28th, a warning dialog will pop up stating that 
no message will be sent in any months that do not have that number of days in the month. See next 
option for Last Day of Month option.

The xx xx of the month: Select first, second, third, fourth, or last and the day of the week (Monday –
Friday) to send the message.                                                                                                          

Example: The message can be sent  the second Tuesday of every month, or the last Friday of every month.

Note: A special option for the “last day of the month” has been programmed. The “last day”  of the month 
option is only available when “last” is selected in the first drop down list of this option.

Start Date: Select the date the scheduled message should begin being sent.

End Date: Select the last day the scheduled message should be sent. If no end date is selected, the message 
will continue as scheduled until deleted from the Scheduled Messages list. Note that the end date will be 
adjusted automatically when the schedule is saved according to the last time the message can be sent under 
the selected schedule.
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Scheduled Messages Queue

The Scheduled Message Queue window lists all upcoming scheduled messages. From this window you can 
view, change, or delete any or all of the currently scheduled messages. 

Note: InfoRad Watch-IT will warn you if there are any scheduled messages pending when you try to exit 
the program. InfoRad Watch-IT cannot send a scheduled message if the program is not running at the 
specified date and time. If the software is not running when a message is scheduled to go out, the message 
will be sent immediately the next time InfoRad Watch-IT is started according to the “Scheduled Messages 
option” in “Preference Options” on page 26.

Edit Schedule: Change the scheduled time, date, or recurrence settings of the message.

Edit Message: Change the text of the message.

Delete Selected: Delete the selected message(s) from the list. Recurring Scheduled Messages will give you 
the option to delete just  the next scheduled delivery or all remaining occurences.
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Delete All: Deletes all scheduled messages in the list.
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Message Queue
When you select “Queue message” from the Options button menu after entering a message, Watch-IT 
automatically creates a Message Dispatch Queue, a holding line for messages waiting to be sent. This 
queue can be edited, allowing you to remove messages before they are sent.

When there are messages in the Message Dispatch Queue, the Send Queue and Edit Queue options under 
the Queue menu become active. If you select Edit Queue from the Queue menu, the Message Queue screen 
will be displayed.

In the Edit Queue screen you can selectively highlight and delete from the queue individual messages or all 
messages in your dispatch queue.

To mark a message for deleting, click on the message line. To delete all marked messages click on the 
"Delete selected" button.

Note: You can select more than one message at a time to delete. To select more than one message, hold 
down the Control (or Ctrl) key when clicking on pages, or use the Shift key to select a range of messages 
(from the currently selected message to where you click).

Click on Ok to close the Edit Queue screen and return to the main screen when you are done with editing or 
viewing the queue.
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Message Logging
You can log all messages going to a wireless receiver, including a time/date stamp. You can select your 
logging preferences when creating or editing a Receiver or Messaging Service directory entry. Logging 
functions, when selected under a wireless messaging service name, affect any receiver entries who use that 
particular wireless messaging service.

When you select “Logged Messages” from the List Menu, the Logged Messages dialog is opened. From 
this window you can view, copy, delete, and print the information stored in your log files.

Today's messages are displayed by default. To view log messages for another date range, enter the date 
range you wish to view then press Enter or click on the Update button. The logged messages are 
summarized by the name of the person they were sent to.

If you wish to view specific messages sent to a individual, click on that person in the list and then click on 
the Details button. All of the logged messages sent to that specific person are then listed, including any 
errors that occurred when trying to send those messages.

To see the full text of any of the messages, simply click on that message. The text will be shown in the Full 
Message Text box. If you wish to copy the information, click on the Copy to Clipboard button. 

To delete all messages in the displayed date range, simply click on the Delete button. Note that the delete 
function will move the file(s) to the Windows® Recycle Bin.

A Note About Log Files
When information is logged on the hard disk, it is generated as a daily file in the InfoRad directory, such as 
“JUL17_05.LOG”. In addition to viewing log files from within InfoRad Wireless, you can also use 
Windows® Notepad or any word processing program to view or print logged messages. 

Note that Log Files contain sender information that is not displayed in the  Logged Messages viewer. To 
view the sender information for a message (Computer Name and Logon Username) open the Log Files with 
Windows® Notepad or other word processor.

Remember to purge your log files occasionally, to conserve hard disk space.
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Directory Maintenance

Directory Listings
Watch-IT allows you to print your directory information, including detailed messaging information, such as 
the number of messages and packets sent. You can generate directory listings organized by Receiver name, 
Receiver number, Group name and Messaging Service. To view a directory listing, select the desired type 
of directory (Receivers, Groups, or Messaging Services) from the Edit menu.

If the directory listing display contains more information than can be displayed on the screen at one time, a 
scroll bar will appear on the right side of the listing so you can move through the listing.

To sort the directory listing, click on the title of the column you would like to sort by. To invert the sort 
order, click on the column title again.

To make a hard copy of the displayed directory information, click on the Print button. When you are 
finished viewing the listing, click Ok.

Clearing Message and Packet Counts

Once you have displayed and printed your listing, you may want to clear the message and packet counts. 
You can clear counts for an individual wireless receiver by clicking the name of the individual and then 
clicking on Clear Counts. If you click Clear All Counts, the system zeros all the counts in the listing. When 
you are finished with the directory listing, click OK.

Note: A wireless receiver’s call count is recorded in increments of one per each message sent. The packet 
count is incremented by one per every 20 characters of message per message sent.

Removing Directory Entries
1. Select the directory you wish to change (Receiver, Group or Messaging Service) from the Edit menu.

2. Once the desired Edit screen is displayed, select the entry you wish to delete and click Delete to 
remove the entry.
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Backing Up and Restoring Directories
Watch-IT offers you the ability to backup and restore your directory database files. You can use this feature 
for backup and to transfer directory information.

Backing Up Your Directories

To backup your directory information:

1. Select “Save Program Files  To” from the File menu. You will be prompted for a directory to 
backup the database files.

2. Select the directory or drive that you wish to save the backup files. Do Not select the Watch-IT 
directory.

Restoring Your Directories

To restore your directory information:

1. Select “Load Program Files From” from the File menu. You will be prompted for a directory 
where the backup files are located.

2. Select the File Types that you wish to restore:

All Program Files –  Loads Database files, Predefined and Scheduled Messages files

Database Files – Loads Database Files ONLY

Message Templates – Loads Message Template files ONLY (*.tml)

Predefined Messages – Loads Predefined Message file ONLY

Scheduled Messages – Loads Scheduled Message file ONLY

Legacy Database Files – Loads Database Files from InfoRad versions 10.0 and prior

(Note that Legacy Database files will not be listed in the Load Program Files Browse dialog unless 
the Legacy Database Files option is selected.) 

3. If you currently have database files, Watch-IT will ask if you are certain you wish to replace the 
current files. Click Ok to load the backup database files.



InfoRad Watch-IT Sending Wireless Messages  99

Exiting Watch-IT

Exiting Watch-IT ASCII and Serial
To Exit Watch-IT, select Exit from the File menu or click on the close box in the upper right-hand corner of 
the main screen.

If you try to exit Watch-IT while there are messages in the message dispatch queue or scheduled messages,
Watch-IT will warn you of their presence. You can choose to return to the Message screen or exit without 
saving the message queue.

Exiting Watch-IT ASCII SV
To exit Watch-IT ASCII SV, select “Stop Service” from the Service Controller.
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Solving Problems

Technical Support
If you are having problems, first make certain that Watch-IT is configured properly:

 General Setup Options

 Watch-IT ASCII and SV Setup (For Watch-IT ASCII only)

 Watch-IT Serial Setup (For Watch-IT Serial only)

 Building Your Wireless Messaging Directories

 Building Your Wireless Messaging Services Directory

 Building Your Wireless Receiver Directory

 Building Your Group Directory (Optional)

Please review the following troubleshooting sections first to assist you with the Watch-IT software system:

 Errors Processing Pages (Access Rights-Related Problems)

 Installation Problems

 ASCII File Processing Problems

 Failed Messages Error Screen (Watch-IT ASCII and Serial)

 Error Codes

 ASCII File Processing (AFP) errors

Should you require additional assistance with InfoRad Watch-IT, please briefly document your problem 
and questions, serial number and version number. 
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Technical Support Options
Technical Support is only available to registered users of the software as detailed in the licensing 
agreement. Please register if you haven’t already.

This program is licensed with 90-days free telephone technical support included. AlphaCare Subscription 
options are available that extend the support period, as well as offer priority telephone support and Upgrade 
Protection. Out-of-warranty support is also available on a per-incident basis..

Please call InfoRad Sales at (800) 228-8998 for details on AlphaCare, or e-mail to sales@inforad.com, or 
see our website at www.inforad.com.

InfoRad Software Technical Support is available Monday through Friday 8:30–5:30 ET.

A technical support section with solutions to common problems is also available at 
www.inforad.com/techsupport

Phone: (216) 531-1369

E-mail: Techsupport@inforad.com

Internet: www.inforad.com
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Errors Processing Pages (Access Rights-Related 
Problems)
For proper operation of the Watch-IT messaging system, certain access rights must be properly set.

If you are having problems or errors when sending messages, try manually sending a page. If you can 
successfully send a page from within the application, you should check the access rights to directories and 
files. This is responsible for the majority of problems in processing wireless receiver message files.

If the access rights are correctly set, please call InfoRad technical support.

Access Rights Settings
Note: Novell rights are shown. If you are using a different network operating system, set the access rights 
to the equivalent rights on your network.

The following are the Watch-IT file access rights required:

Key:

R Read
W Write
C Create File
E Erase or Delete File
M Modify File
F Filescan and Directory Control (i.e., rename a file)

Item Rights

Program Directory RWCEMF

Message Directory RWCEMF

Windows Networks
For Windows networks, set the access type for file sharing to SHARED with  FULL access for the drive 
and directory that is being shared.
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Installation Problems
If you are having problems installing Watch-IT, check the following:

1. Watch-IT installs to any drive and runs from any drive assignment. The standalone version of 
Watch-IT supports local drives only. The network version of Watch-IT supports local or network 
drives. 

2. To install Watch-IT in Windows® 2000 and greater, click on the Start button and select Run. 
Browse to your CD or floppy drive and select SETUP.EXE, and then click on OK.

3. Watch-IT only requires 2mb of hard disk space for normal operation. Make sure that you have 
sufficient hard disk space for the installation.

ASCII File Processing Problems
If you are experiencing difficulty with ASCII file processing, examine the error status files.

Note: If you cannot find an error status file in the messages directory, ensure that the “Create Status Files” 
option is selected in the ASCII File Setup dialog (see “ASCII File Options” on page 32). Also, refer to 
“ASCII File Setup” on page 33 for details on configuring the error filename format.

Error status files are automatically generated when there is a problem processing an ASCII file, and can be 
viewed with any editor or by using the TYPE command in DOS. Error files contain a short error message 
describing the problem, and can be used as a troubleshooting aid.

With Watch-IT ASCII and Serial, you can also send the message from the console (see “Sending Wireless 
Messages” on page 81) to help aid you in locating potential problems.

The “Error Codes” section contains typical errors and possible resolutions.
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Failed Messages Error Screen (Watch-IT ASCII 
and Serial)
Note: The Failed Messages Error Screen is only available in Watch-IT ASCII and Watch-IT Serial. If you 
are using Watch-IT ASCII SV, the error codes are listed in the message status files.

The Failed Messages Error screen lists all messaging errors that have occurred, including the type of 
problem, the probable cause of the problem, and any messages from the messaging service. You can scroll 
through the errors to examine each error.

To cancel a message, click on the message line for that message. To cancel all messages click on the 
“Cancel All” button.

Note: You can select more than one message at a time to cancel. To select more than one message, hold 
down the Control (or Ctrl) key when clicking on the messages, or use the Shift key to select a range of 
messages (from the currently selected message to where you click).

To try and send the messages again, click on the “Try again now” button. If you wish to postpone Watch-IT 
from attempting to send the messages again, click on the “Try again Later” button. This moves the 
messages back into the send queue, where they can be sent at a later time by clicking on the “Send Queue” 
button from the main screen.
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Error Codes

Local Errors
Local errors are errors that are the result of problems with the local computer; that is, the one InfoRad 
Wireless Enterprise is running on.

For local errors, check the following:

 Make sure the modem is properly connected and turned on.

 Verify your modem selection, advanced settings, and other modem options are correct in 
Communications Setup. 

 Check to see if any other communications program is currently using your modem or hasn’t 
properly disconnected from it.

 Reset or power down your modem. If it is an internal modem, power your system down and 
reboot.

(1104) Local Error: Could not access modem

This means InfoRad Watch-IT tried to open the comport and could not get a response from the modem. 
This could be because the port could not be opened (port was busy, or does not exist) or because the 
modem did not respond (modem was turned off, or is on another port, etc.).

(1105) Local Error: Line is not available

This means that the line device selected for sending pages is unavailable. Usually this means that the line is 
in use by some other application.
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Remote Errors
Remote errors are what happens when the remote system (the wireless messaging service) reports a specific 
error or when there is difficulty communicating with the wireless messaging service. These errors happen 
after a connection with the messaging service has been established. 

(1201) Remote Error: Could not handshake with service

InfoRad Watch-IT was able to CONNECT to the answering modem, but is receiving no further response 
from the messaging service.

 Check to insure the messaging service modem access number is correct. Note that it may also be 
called the Terminal phone number, Alpha Port phone number, Access number, or PCS short 
messaging service (SMS) phone number.

 Check the messaging service communication parameters – Baud Rate, Data Bits, Parity, and Stop 
Bit. (Note: Most wireless messaging services are 1200 Baud, sometimes 2400 or 300; and are 
almost always 7 data bits, even parity, 1 stop bit.)

 Check the modem selection in the Communications Setup for proper modem type.

 Select “Override” in the Modem Configuration dialog, and then click on the Create button to build 
a unique initalization string for your modem.

 Reference the ‘Using High Speed and Fax modems’ section of the manual or on-line Help and 
your modem’s manual (reference AT command section) to construct a modem initialization string
for your modem.

 Check with your modem manufacturer to insure your modem supports the wireless messaging 
service Baud Rate and data settings (Ex: 1200, 7, even 1).

(1202) Remote Error: Service did not respond to message

The wireless messaging service did not return any response code after InfoRad Watch-IT sent a data block; 
generally a result of a poor connection, or can be a problem at the messaging service.

 Retry sending the message(s).

 If received when sending multiple messages, check with your wireless messaging service for any 
limit on the number of messages that can be sent in a single dial-up session.

(1203) Remote Error: Message was not acknowledged

The wireless messaging service responded to a data block with the NAK code. 

 Retry sending the message.

 Remove the area code from the wireless receiver ID number (text pagers).

 Verify the proper wireless receiver ID number is entered.

 Use the wireless receiver’s PIN number. 
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(1204) Remote Error: Forced to abandon by service

The wireless messaging service responded with the abandon code. This means the wireless messaging 
service is rejecting the message.

 A “[P” in error messages in the Failed Messages error screen indicates that the program is starting 
to send the message – if disconnects occur at this point it usually indicates an invalid wireless 
receiver ID number.

 Verify that the proper wireless receiver number is entered. Sometimes wireless receivers are 
assigned two numbers. One number for numeric messaging from a phone and another for the 
wireless receiver identifier when remote messaging (PIN number). Verify with your wireless 
messaging service which number to use.

 You may need to verify with the wireless messaging service that the wireless receiver number is 
activated, programmed for text or short messaging (not numeric-only messaging), and that you are 
using the correct service number for text messaging.

 If you are using a dialup modem connection, verify that there is no area code in the pager number. 
If you are using an internet connection, verify that the area code is included.

 Verify that you are dialing the correct service number for your wireless receiver—messaging 
companies sometimes have multiple service numbers, and your wireless receiver ID number must 
be valid on the system to which you are connecting.

 Some messaging companies will reject messages if the message is too long. Try sending a short 
message. If it successfully sends, verify the allowable message length with your wireless 
messaging service, and then set the message size in the wireless messaging service setup.

(1205) Remote Error: Service forced a disconnect

The wireless messaging service sent InfoRad Watch-IT the disconnect code. This can happen when the 
service does not accept InfoRad Watch-IT’s response to the login prompt.  

 Check that any password is valid in the Wireless Messaging Service setup advanced properties. 
(Note that most wireless messaging services do not require a password.)

 A “[P” in error messages in the Failed Messages error screen indicates that the wireless receiver 
ID # is incorrect—try and use the PIN number and not the wireless receiver phone number in the 
receiver’s ID Number field. Double-check the receiver ID to make sure it was correctly entered.

 Some messaging companies will reject messages if the message is too long. Try sending a short 
message. If it successfully sends, verify the allowable message length with your messaging 
company, and then set the message size in the wireless messaging service.

 Make sure the wireless receiver has been activated or not disconnected by the messaging 
company. Optionally, try messaging it from your phone as a numeric pager.

 Verify that you are dialing the correct access number for your receiver—wireless messaging 
services sometimes have multiple systems, and your wireless receiver number must be valid on the 
system to which you are connecting.
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(1206) Remote Error: Invalid reply to login

The messaging service did not properly respond after InfoRad Watch-IT’s login. 

 Retry sending the message.

 Check the data bits and parity settings (Messaging Service Advanced Settings).

 Check that any password is valid.

 Try changing the baud rate (Messaging Service Advanced Settings).

 Check the modem selection in the Communications Setup to ensure that the proper modem is 
selected.

 Select “Override” in the modem configuration, and click on the Create button to build a custom 
initialization string for your modem.

 Reference the ‘Using High Speed and Fax modems’ section of the manual or on-line Help and 
your modem’s manual (reference AT command section) to construct a modem initialization string
for your modem.

 Check with your modem manufacturer to insure your modem supports the messaging service Baud 
Rate and data settings (Ex: 1200, 7, even, 1).
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Communications Errors
These errors report problems establishing or maintaining the link between the wireless messaging service 
and the local computer, whether the source of the problem is the wireless messaging service, the local 
computer, the phone network, or anything else.

(1301) Communications Error: Could not connect with remote modem

This appears when the phone was successfully dialed, but no “CONNECT” message was received.  
Common causes are bad service phone numbers, bad modem initialization strings, bad modems (on either 
end), incorrectly installed modems (no dial tone) and so on.

 Verify that you correctly entered your messaging service phone number and parameters such as 
baud rate, data parity, and stop bits. You should always hear a high-pitched modem connection 
tone when dialing the correct number. If your modem speaker is turned off, try dialing the
messaging service phone number from a telephone to verify that there is a modem connection tone 
when connecting.

 Verify your modem selection or custom init string. If you are using a Fax or high-speed modem 
disable the data compression and error correction features; see Using High Speed and Fax 
Modems section for more information.

 Verify that you are dialing the correct service number for your wireless receiver—messaging 
services sometimes have multiple service numbers, and your wireless receiver number must be 
valid on the number you are dialing.

 Verify your dialing location settings and selection.

 Check if the messaging service requires a password, and if so, verify that password (normally, 
messaging services don’t use a password).

 Double-check the custom modem initialization string, if the “override” option was used during 
modem setup.

 Make sure the modem isn’t attempting to connect to a fax number.

 The wireless messaging system may be experiencing technical difficulties. Check with your 
messaging service.

(1303) Communications Error: There was no dial tone on the dialing line

This appears when the local modem could not detect a dial tone, and so could not begin dialing.

 Verify the modem is correctly installed.

 Check to see if  the phone line is in use or is working properly.

 Verify that your modem has power, that you have dial tone at your modem, and that your phone 
line is plugged into the modem jack labeled “line.”

 Verify that your dialing location and options are correct (Windows “Telephony” or “Modems” 
control panels).

 Verify your modem selection.

 If you have a digital phone system, you may need to use a special jack to access an analog phone 
line. Plugging your modem directly into a digital phone system will not work, and may damage 
the modem or the phone system.
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(1304) Communications Error: The called number was busy

This appears when the program has already redialed the service provider the specified number of times, and 
received a busy signal every time. 

 Verify the messaging service access number is correct.

 Check if the messaging service is busy or experiencing problems.

 Increase the re-dial on busy setting in Communications Setup, Advanced Modem Settings, Dialing 
Options.

(1399) Communications Error

The generic communications error that appears when there is some problem reading data from the 
communications port.

 Check for any device conflicts.
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TAPI errors
TAPI errors report problems setting up and using the Windows telephony interface. These errors should 
represent problems that are specific to TAPI, and not to the process of sending pages in general.

For TAPI errors, unless specified below, check the following:

 Check other programs that utilize TAPI for a similar problem.

 Verify the TAPI setup/installation for the operating system.

 Verify that your system is using TAPI 1.4 or above.

 Verify that you modem is setup properly in the operating system.

 Check for any device conflicts.

 Check for any software conflicts.

 Try deleting the current modem configuration in the Modems Control Panel and then adding it 
back.

 Check your TAPI location selection and settings (dialing options) in the Windows “Telephony” or 
“Modems” control panels.

(1400) TAPI error: TAPI initialization failed

To start up TAPI, the program must load some TAPI / operating system DLLs. If the DLLs cannot be 
loaded, this error will appear.

(1401) TAPI error: Could not negotiate common API version

There are different versions of TAPI available. Windows 95 shipped with TAPI 1.4, Windows NT 4.0 
shipped with TAPI 2.0, and Windows 98 shipped with TAPI 2.1, and TAPI 2.2 shipped with Windows 
2000, XP, and 2003 Server. InfoRad Wireless tells the system that it can support TAPI 2.0 and the system 
responds by enabling only the features available in that version. If there is some problem with this process 
(for example, if the system only supports TAPI 1.3 or lower), you may see this error. 

(1402) TAPI error: Unable to query TAPI address capabilities 

Before placing a call on a device, the program queries TAPI about the line’s capabilities. This message 
shows up when TAPI will not or can not respond to the request. 

(1405) TAPI error: Selected device does not support data calls

TAPI devices include modems, fax boards, ISDN telephones, and other devices, not all of which can 
transfer data the way modems can. Before sending messages, InfoRad Wireless checks to be sure that the 
device the user selected is in fact a data modem, and not some other TAPI device. 

(1410) TAPI error: Could not open line device

Before placing a call, InfoRad Wireless checks to be sure that the line is available (and shows error 1105 if 
it is not), but if there is some problem opening the line (even if TAPI claimed the line was available) this is 
the error message.

(1415) TAPI error: Could not specify status messages to monitor

After opening a line device, InfoRad Wireless informs TAPI which status messages are important for the 
call. If there is a problem doing this, this error appears.
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(1425) TAPI error: Could not specify port settings prior to opening port

Before placing a call, InfoRad Wireless attempts to set the baud rate, data bits, stop bits, flow control, error 
correction and data compression settings specified for the modem and messaging service in use. If there is a 
problem doing this, this error appears.

 Verify with your modem manufacturer that your modem supports the baud rate and data settings 
required by your messaging service (usually 300, 100, or 2400 baud with 7 Data Bits, Even parity, 
1 Stop Bit).

(1435) TAPI error: Could not create call parameters

This error appears if the data structure containing parameters for TAPI cannot be created. This would only 
happen if the computer ran out of memory.

(1440) TAPI error: Call to lineMakeCall() failed

InfoRad wireless uses the lineMakeCall() function of TAPI, which opens the serial port. This error appears 
when this call fails.

(1450) TAPI error: No response to lineMakeCall()

After placing a phone call with TAPI, InfoRad Wireless expects to get some responses back from TAPI, 
including an announcement that the modems have either connected or disconnected. If those responses 
don’t arrive within 60 seconds, this error appears.

(1455) TAPI error: Couldn't get port handle from TAPI

After placing the phone call, InfoRad Wireless asks TAPI for direct access to the COM port, through which 
it can send and receive data. If the port handle is unavailable for some reason, this error appears.

(1460) TAPI error: Could not change call parameters

After dialing a call in Override mode (Modem Configuration), InfoRad Wireless attempts to switch back to 
standard TAPI mode to actually send pages, then hang up. If the switch back to standard TAPI mode does 
not work, this error appears.

(1499) TAPI error: Unexpected TAPI error

This is error message used in cases where InfoRad Wireless is able to detect that something has gone 
wrong with TAPI, but the error is not one of the above listed errors.
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TAP Errors
The TAP protocol includes provision for a messaging terminal to report 3-digit error codes back to the 
InfoRad software that is trying to send a page. The last three digits of a TAP error are always the same as 
the digits reported by the paging system. For example, if the TAP terminal returns error code 501, InfoRad 
products would show the user error 2501.

(2112) TAP error: Maximum pages entered for session

Some Services limit the number of messages that can be sent in a single session. Check with your 
Messaging Service for their limit. Exceeding the maximum number allowed per session will result in this 
message. This message might result when sending to large groups, multiple groups, or a large ad hoc group.

(2113) TAP error: Maximum time reached for session

Some Services limit the session connection time when sending messages. Sending to large groups, multiple 
groups, or a large ad hoc group may result in this error. Check with your Messaging Service for their limit.

(2212) TAP error: Long message truncated and sent

Some services will automatically truncate and send a long message at the Services Maximum Message 
Length allowed by the system. Check with your Service for their Maximum Message Length. Make the 
change to the Messaging Service setup and turn On AutoSplit to avoid this error.

(2214) TAP error: Long message truncated and sent

Paging terminal sent the first X characters of the message, where X is the maximum characters per page 
allowed. These two errors differ only in that the terminal sends a message along with 2214 that indicates 
what X is. Since this information is not currently parsed or used in any way by InfoRad products, both 
errors show the same message text.

(2501) TAP error: A time out occurred while waiting for input

During Message sending if the Service does not see a response within a specified period this error results. 
Usually this is caused by a poor connection. Retry sending the message.

(2502) TAP error: Unexpected characters received before start of 
transaction

Terminal did not get either the <STX>(message block) or <EOT><CR> expected after the client software 
logged in OK. Could indicate line noise or a timing problem.

(2503) TAP error: Excessive attempts to send/re-send transaction

When the terminal finds that a page contains checksum errors (theoretically the result of line noise), the 
client software may try to send the message again. If this happens too much, the terminal can end the 
session with this error message.

(2504) TAP error: Message characters not allowed for this receiver

The page as the terminal received it contained message characters, and the terminal does not recognize that 
the PIN belongs to a pager with message receiving capabilities. The pager could be a simple beeper or 
“tone only” device. Note differences between this message and 2505.

(2505) TAP error: Message text not allowed for this receiver

The page as the terminal received it contained alphabetic characters, and the terminal does not recognize 
that the PIN belongs to a pager with alphabetic message capabilities. The pager could be a standard 
numeric or “digital” pager. Note differences between this message and 2504.
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(2506) TAP error: Excessive invalid pages received

Sending multiple messages that contain invalid Receiver ID's could result in this message. Check the 
programming of Receivers, or check if the Service has other Dial-up Modem ports for sending messages 
and for which Dial-up Modem port to use with your specific Receivers.

(2507) TAP error: Login failed, bad login sequence

If this message is received it could be a bad connection – try resending the message. Continued errors -
check your Data Settings in the Message Service setup (typically should be 7 data, Even Parity, 1 Stop).

(2508) TAP error: Login failed, service not supported

The “service” in this error message refers to the service type specified just before the password in the 
standard TAP login sequence. The only services currently supported are “PG1(password)” (for automatic 
page entry) and “M” (for manual message entry), but InfoRad products only send the “PG1” sequence.

The TAP standard does mention that other services may be added to the TAP protocol, so there is the 
possibility that there could be a TAP terminal that did not support paging, that is, the “PG1” service type. 
This is the error that would result from using InfoRad products to send a page to such a terminal.

(2509) TAP error: Login failed, bad password

Incorrect password. Typically Services do not require a password and the password field in the Service 
setup shuold be blank.

(2510) TAP error: Illegal receiver ID

TAP system was expecting the receiver PIN to have a different number of digits, to not contain characters 
that it did contain, or otherwise be very different. The PIN as received is so screwed up, it can’t even be 
looked for in a database of PIN numbers.

(2511) TAP error: Unrecognized receiver ID

TAP system does not have a record of any receiver with the PIN number sent. Very common problem with 
pagers, since the pager’s telephone number and alphanumeric PIN number are sometimes different, and the 
people selling the pagers sometimes don’t know that.

(2512) TAP error: Temporarily unable to deliver messages to this receiver

Possibly used on two-way systems that know the target pager is not in the service area.

(2513) TAP error: Message exceeds maximum length, rejected

Paging terminal has refused to send a message because it contained more than X characters, where X is the 
maximum characters per page allowed. 

Check with your Messaging Service for their Maximum Message Length and change the settings in the 
Messaging Service setup and turn on AutoSplit to avoid this error.

(2517) TAP error: Message exceeds maximum length, rejected

Paging terminal has refused to send a message because it contained more than X characters, where X is the 
maximum characters per page allowed. 

Check with your Messaging Service for their Maximum Message Length and change the settings in the 
Messaging Service setup and turn on AutoSplit to avoid this error.

(2514) TAP error: Bad checksum

This error is usually caused by a poor connection / noisy line. Retry sending the message.
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(2515) TAP error: Message format error

May be caused by a poor connection / noisy line. Retry sending the message.

(2516) TAP error: Message quota temporarily exceeded

Some receivers may be limited to the number of messages per day or per month, or attempting to send too 
many messages in a short time period to a specific receiver that might exceed the receiver's capability. If 
this limit is exceeded this error may result. Check with your Messaging Service about any limits or 
restrictions on the specific pager.
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ASCII File Processing (AFP) errors
Errors specific to the Watch-IT File Processor (AFP) module.

(4001) AFP error: Name does not exist in pager or group list 

The AFP was able to read an ASCII file, but the word or words interpreted as the name of a pager or a 
group of pagers did not match any pager or pager group in the Watch-IT database.

 Check for correct spelling of the name or group name in Watch-IT or in the application generating 
the message. 

 Remove any excess spaces in the name in Watch-IT.

(4002) AFP error: Service does not exist in service list

The AFP read an ASCII file which it determined contained a pager number and a messaging service name. 
The word or words interpreted as the service name did not match any messaging service in the database.

 Check for correct spelling of the messaging service in Watch-IT or in the application generating 
the message. 

(4003) AFP error: Incomplete message file

The AFP did not find all of the mandatory entries (header, recipient, and message contents) in the ASCII 
message file.

 Check the application generating the message file for proper formatting.

(4005) AFP error: No Header found

The AFP did not find the mandatory header  in the ASCII message file. The default header is "MSG: ".

Check the application generating the message file for proper formatting.
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Network Errors
Network errors indicate a failure in the process of connecting to the internet, finding the paging server on 
the internet, or actually sending the page to the paging server.

(6001) Network error: Could not connect to internet

Winsock services could not be started, RAS could not be started, or a RAS connection could not be 
established.

(6002) Network error: Could not connect to host

Most likely caused by problems with the host name or address as entered in the paging service setup or the 
telnet proxy setup. May also indicate that the host itself is down, or that part of the network connecting the 
user’s computer to the host is down, or that the host is simply not accepting connections on the specified 
port.

(6101) Network error: Socket I/O operation failed

Some unexpected error occurred while sending or receiving data.

(6201) Network error: Host terminated connection

The remote host (the SNPP server, or possibly the telnet proxy server, if one is configured) disconnected 
without warning.

(6202) Network error: Timed out waiting for server

The timeout for the paging service (set up in the paging service properties screen) elapsed with no response 
from the SNPP server. This problem can sometimes be rectified by increasing the timeout, but it may 
indicate something wrong with the SNPP server or with the network connection.

(6203) Network error: Host returned error code

SNPP server responded to an SNPP protocol command with a failure code. When this error happens, the 
explanation text sent by the SNPP server will be included on the error screen along with this error message. 
That explanation should provide more detail on why the transaction failed. The explanation might be, for 
example, “550 Error, pager ID must be 10 digits” or “550 Error, pager ID cannot be identified” and so on.

(6301) Network error: Target address or URL appears to be invalid

The URL address for the Messaging Service could not be parsed in order to attempt a connection. Check 
the Messaging Service address.
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WCTP Client-side Errors

(7000) WCTP Error: Could not read WCTP response

Message to a WCTP gateway was able to POST, but the WCTP gateway response was unreadable. Attempt 
to re-send.

(7001) WCTP Error: WCTP response was garbled, invalid, or unrecognized

The WCTP gateway reply to a message was OK, but the text of the reply cannot be read or is unrecognized. 
This can happen when a valid web page URL is entered in the Messaging Service WCTP address instead of 
a valid WCTP gateway address. (Any web server will send a reply back to an HTTP POST operation, but 
the reply will be HTML and not XML. XML is the expected format of a reply from a WCTP gateway.)

(7002) WCTP Error: Could not POST WCTP message to gateway

Could not connect to the WCTP gateway. Most likely an invalid address was entered in the Messaging 
Service WCTP address.

(7003) WCTP Error: Bad HTTP status code (check server address?)

The HTTP session returned an error code, or no response from the HTTP session was received. This can 
happen when a valid web page URL is entered in the Messaging Service WCTP address instead of a valid 
WCTP gateway address. The internet log (inetlog.txt) may contain the specific HTTP error for further 
clues.

(7004) WCTP Error: HTTP 407 Proxy Authentication Required

The HTTP session returned a Proxy Authentication error. This can happen when the Internet Connection 
uses a Proxy Server and you have not turned on Proxy Authentication in the program Internet Setup 
options. Turn on Proxy Authentication in the Setup Menu . Internet Settings. Enter your Username and 
Password.

(7005) WCTP Error: HTTP 407 Proxy Authentication – bad 
username/password

The HTTP session returned a Proxy Authentication error. This can happen when your Proxy Authentication 
setup contains an incorrect Username or Password. Edit the Proxy Authentication Username and Password 
in the Setup Menu . Internet Settings. Check with your Network Administrator for the correct Username 
and Password for Proxy Authentication.

WCTP Server-side Errors
These errors are of the format “7xxx” where “xxx” is the WCTP error code. These are errors returned by 
the WCTP gateway. The text of the error message indicates the problem.
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Watch-IT ASCII SV Service Controller Error Messages
When a system error occurs in the InfoRad Watch-IT NT, the service controller application will display a 
dialog listing the Windows error number and description of the error.

The errors listed are Windows error messages. The following are some possible specific error messages:

System code 5: Access is denied (Windows NT)

You don’t have administrator rights on the machine you are attempting to connect to. To use the service 
controller, you have to log in to an account that the service machine will recognize as having administrative 
rights. If your computers are part of a network domain, log in as the domain administrator.

System Error 53: The network path was not found

No computer with the name you typed is visible from your computer. It’s possible that the computer you 
want to connect to is turned off or not logged in to the network, or maybe you made a typo when you typed 
the name.

System Error 997: Overlapped I/O operation 

1) You don’t have administrator rights on the machine you are attempting to connect to. To use the 
service controller, you have to log in to an account that the service machine will recognize as 
having administrative rights. If your computers are part of a network domain, log in as the domain 
administrator.

2) The service program is not installed on the computer you connected to. If you are sure you 
installed the service before running the service controller, check to be sure you typed the correct 
computer name

System code 1060: The specified service does not exist as an installed 
service 

The service program is not installed on the computer you connected to. If you are sure you installed the 
service before running the service controller, check to be sure you typed the correct computer name.
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Watch-IT ASCII SV Troubleshooting Tips

Clients send messages to the service, but the service never dials and never 
sends the page.

Check that the service is running. You can do this with the service controller or with the Services Control 
Panel applet on the service machine.

When I try to connect to the service computer, the service controller 
reports “System Error 997: Overlapped I/O operation”

Be sure that you’ve typed the computer’s name correctly. This message can show up if you’ve connected to 
the wrong computer (one that does not have the service installed) or if you have not installed the service 
yet; or if you do not have Admin rights on the computer running the Watch-IT ASCII SV Service.

You can use the Services control panel applet on the service computer to verify that the service is installed. 
You must be logged in as the Administrator to do so. From the start menu, pick Settings, then Control 
Panel. Double click on the Services icon. Installed services are listed in alphabetical order; the service for 
the InfoRad Watch-IT ASCII SV system should be listed as “InfoRad Watch-IT ASCII SV Service.”
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Other errors

Modem is Not Dialing

General Notes on Dialing Problems:

 Check to see if any other application is using the modem.

 Make sure that the phone line is plugged into the “Line” jack of the modem, and not the “Phone” 
jack.

 To rule out software conflicts, turn off any fax receive software, communications software, or 
remote control software before trying to send a message.

 Verify your modem selection

 Check for possible device conflicts.

After dialing a voice or a ring and a beep is heard

 Verify the phone number you entered in your Messaging Service setup. You should always hear a 
modem connection tone when dialing the correct number.

 Hearing a “ring and a beep” means you have inadvertently programmed a receiver number into
your messaging service access phone number.

“Tone Only” or a blank message, only numbers are sent, or message is 
garbled or incomplete.

If the message  to a wireless receiver is incomplete or garbled, check for the following possible problems:

 Check for a “Message Sent” status in InfoRad Watch-IT. This indicates that the wireless receiver 
message was successfully sent to the wireless messaging service. The wireless messaging service 
then radio-transmits that message to the wireless receiver(s).

 Check for a low battery in the wireless receiver.

 The wireless receiver could be out of range or in a fringe coverage area for transmission.

 The wireless receiver could be in a building with strong RMI (Radio Magnetic Interference i.e., 
near many computers).

 The wireless receiver could be in a building or area of a building that is difficult to penetrate with 
radio transmissions.

 Weak or inoperative wireless receiver (i.e. bad wireless receiver).

 Pagers: Try using the PIN number instead of the pager phone number.

 Verify that the wireless receiver has been programmed at the wireless messaging service as an 
alphanumeric (text) pager or PCS short messaging receiver. If the wireless receiver is receiving 
numeric characters in the message but not the letter characters – the wireless receiver has been 
programmed as a numeric-only wireless receiver in the wireless messaging service system and 
needs to be programmed for alphanumeric/text.
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Upgrading Watch-IT

Watch-IT ASCII Versions
There are several versions of Watch-IT ASCII available:

Watch-IT ASCII-75: A limited version of Watch-IT ASCII: Limits 75 Receivers in the messaging 
directory/database. No ‘Manual Messaging’ capabilities in Message files. (See “Manual Messaging in
Message Files” on page 68 for more information.)

Watch-IT ASCII: Provides automated dispatch of wireless messages by monitoring a file directory for 
ASCII text messaging files. Unlimited number of Receivers in the messaging directory/database. Also 
permits ‘Manual Messaging’ in message files, allowing messaging information to be provided from outside 
of the Watch-IT ASCII application. (See “Manual Messaging in Message Files” on page 68 for more 
information.)

Watch-IT ASCII SV: Provides the same features as Watch-IT ASCII, but has been optimized to run as an 
Windows Service under Windows® 2000 and greater.

Watch-IT Serial: Provides automated dispatch of wireless messages by monitoring a serial port 
information stream.

Please contact InfoRad Sales or see the InfoRad Website for more information and FREE / fully functional 
Trial downloads. 

See “Contacting InfoRad Sales” on page 124.

InfoRad Wireless Enterprise Upgrade
InfoRad Wireless Enterprise is a client/server messaging system for local area networks (LAN) and wide 
area networks (WAN) or for networks that require message polling or central processing of text messages.

The InfoRad Wireless Enterprise upgrade utilizes Watch-IT ASCII as a messaging server and adds InfoRad 
Wireless Pro/AlphaPage® First Responder as the client application for network users. Add the power of 
client messaging while retaining the automated dispatch functions of Watch-IT. InfoRad Wireless 
Enterprise SV also available. Enterprise SV server runs as a Windows Service on Windows® 2000 and 
greater.

Please contact InfoRad Sales or see the InfoRad Website for more information and FREE / fully functional 
Trial downloads. 

See “Contacting InfoRad Sales” on page 124.
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Contacting InfoRad Sales
For more information or pricing on the full line of InfoRad products, please contact InfoRad Sales:

Toll Free: 800-228-8998

Phone: 216-531-1313

Fax: 216-531-8383

Internet: sales@inforad.com

WWW: www.inforad.com
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Addendum T

About Message Templates
Message templates allow you to create custom message entry screens.  This can be useful if you send many 
messages that contain identical or very similar information.  Much (or all) of the message text can be 
defined in advance, which can save time and reduce mistakes.  Here’s an example of a message template 
that might be useful for a singing telegram service:

The text message includes all of the editable and non-editable text on this screen.  In this case, the message 
would be:

Singing telegram scheduled for 04/04/2005 14:00 Recipient: Sally Sender: Tom Song: Happy 
Birthday Address: 123 Main Street, Anytown Notes: Sally’s 40th Message sent at 04/04/2005 
12:00

Message templates are created from simple text files that may be created or edited with Windows Notepad.  
We’ll call these files template definition files.  Template definition files are saved with a .TML filename 
extension in the program directory.
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Creating Message Templates
To illustrate how message entry templates are written, we’ll first look at a very simple example:

The template definition file for this custom message entry screen is:

title text "Say Hello"
static text "Hello from "
edit required length 30

This file was saved with the filename “hello.tml” in the program directory.  To use it, a user chooses 
message recipients, then picks “Template Message…” from the Options menu.  A list of message templates 
appears, and the user double-clicks on “hello.tml” to see this screen.

The first thing to notice about this template definition file is that each item in the message entry screen 
occupies a separate line in the template definition file.  The screen title occupies exactly one line, the block 
of static text occupies exactly one line, and the text edit field occupies exactly one line.  Template 
definition files must always be written this way.

On each line, the first word indicates what sort of item the line is defining.  We’ll call this an item type.  In 
this simple definition file, there are just three item types: title, static, and edit.  There are a few other item 
types available, but we’ll start with these basics.

Each line contains some words after the item type.  We’ll call these additional pieces of information item 
properties.  Item properties specify additional information about how each item type is handled.  For 
example, the last line includes the word “required.”  This is an item property that means the edit field must 
be filled in before the message may be sent.  There are a few other item properties specified here.  Some 
item properties are just a single word, like “required,” and others are groups of words, like “length 30”.
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If we were to break this template definition file down into item types and item properties, we’d get 
something like this:

Item Type Item Property Item Property

title text “Say Hello”

static text “Hello from ”

edit required length 30

In this example, only the last line has more than one item property. The first two lines have the text 
property, which is always followed by a string of characters in quotes.  Some item types (like title and 
static) will be permanently set to the supplied string of characters.  The edit item type also is set to the 
string of characters, but can be changed by the user. It's not possible to apply every item property to every 
item type.  Each item type has a few properties that make sense for it.  If a template definition file attempts 
to apply a property to an item type that can't use that property, the program will display an error message.  
Here are the allowed item properties for the item types in our simple example:

Item Type Properties Allowed

title text

static text

edit text, required, length, nochange

More complete information is included in the Message Template Reference section, “Item Type Summary” 
on page 129 and “Item Type Details” on page 130.

We can see that the title and static item types are very simple, but the edit item type has a few more settings 
we can try.  Suppose your name is George, and you want your Hello message template to always start with 
your name already typed-in.  You could change the message template to read:

title text "Say Hello"
static text "Hello from "
edit required length 30 text "George"

Now when you use the message template, it will look like this, without any typing:

Now you can say hello without typing, but a friend using your PC can also use the template, if they change 
the name.

Perhaps you've decided that since your name is so short, you may as well save a little room on the screen 
and trim the name length.  You might change the message template to read:

title text "Say Hello"



128  Addendum T InfoRad Watch-IT

static text "Hello from "
edit required length 10 text "George"

With the shorter edit length, the screen will look like this:

Maybe your friend Tom has been using your computer to say hello so often that he's become a real pest, 
and you want to prevent him from doing that any more.  You might change the message template to read:

title text "Say Hello"
static text "Hello from "
edit required length 10 nochange text "George"

With the nochange property, the screen will look like this:

The nochange property turns the editable field gray and prevents it from being changed.  It's functionally 
equivalent to the static item type.  This is a somewhat silly example - Tom would probably stop saying 
hello from your computer if you asked him to - but the nochange property may be useful if you make many 
similar template files, but want to make some editable fields non-editable in some of them.
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Message Template Reference

Item Type Summary

Type Included In 
Message?

Properties About

newline no (none) Makes a line break in the message entry 
screen (but not in the message)

title no text Sets the title of the message entry screen

static yes text Adds non-editable text to the message entry 
screen

time yes auto

nochange

Adds a time control to the message entry 
screen.

date yes nochange Adds a date control to the message entry 
screen.

datetime yes auto

nochange

Adds a date and time control to the message 
entry screen.

hours yes auto

nochange

Adds an hours control to the message entry 
screen.

minutes yes auto

nochange

Adds a minutes control to the message entry 
screen.

edit yes required

text

length

nochange

Adds an editable field to the message entry 
screen.

editml yes required

text

length

height

width

nochange

Adds a multi-line editable field to the 
message entry screen.
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Item Type Details

newline
newline

Adds a line break to the message entry screen without affecting the message text. Prevents the message 
entry screen from getting too wide for the screen or for reading comfort.  For example, this template 
definition is pretty wide; if it got much wider, the message entry box wouldn't fit on some screens:

static text "One item: "
datetime auto
static text "Two items: "
edit length 20 

Here's how it looks:

With the addition of a newline, the readability and expandability improve:

static text "One item: "
datetime auto
newline
static text "Two items: "
edit length 20 

Here's how it looks:



InfoRad Watch-IT Addendum T  131

title
title text "The Name Of The Game"

Sets the title displayed on the message entry screen.  Does not affect the message text.

Property Effect

text "Your Text 
Here"

Sets the screen title 
to Your Text Here

static
static "The rain in Spain"

Includes non-editable text in the message entry screen. 

Property Effect

text "Your Text 
Here"

Includes Your Text 
Here in message

time
time auto

Includes a time control in the message entry screen.  The time is shown in 24-hour format ("military time").  
The time displayed initially is "00:00" unless the auto property is used.  A user may change the time 
displayed with the up/down buttons, by typing numbers, or by using the up/down cursor keys.

Property Effect

auto Initially shows the 
current time.

nochange The time shown 
cannot be changed.
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date
date auto

Includes a date control in the message entry screen.  The date format is month/day/year.  The current date is 
always displayed initially.  Clicking the down arrow displays a calendar that can be used to select dates.  
The keyboard and up/down cursor keys can also be used to change the date shown.

Property Effect

nochange The date shown cannot be changed.

datetime
datetime auto

Includes a date-and-time control in the message entry screen.  The date format is month/day/year.  The 
current date is always displayed initially.  The time is shown in 24-hour format ("military time").  The time 
displayed initially is "00:00" unless the auto property is used. Clicking the down arrow displays a calendar 
that can be used to select dates.  The keyboard and up/down cursor keys can also be used to change the 
time and date shown.

Property Effect

auto The time control initially shows the 
current time (the date is always 
initially the current date).

nochange The date and time shown cannot be 
changed.
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hours
hours auto

Includes an hours control in the message entry screen.  The field is limited to the range 00 to 23.  "00" is 
initially displayed unless the auto property is used.  The hours shown can be changed with the up/down 
buttons, the up/down cursor keys, or by typing digits on the keyboard.

Property Effect

auto Initially shows the hours of the 
current time (i.e., at 11 at 11:45, 4 at 
4:03 etc.)

nochange The hours shown cannot be changed

minutes
minutes auto

Includes a minutes control in the message entry screen.  The field is limited to the range 00 to 59.  "00" is 
initially displayed unless the auto property is used.  The minutes shown can be changed with the up/down 
buttons, the up/down cursor keys, or by typing digits on the keyboard.

Property Effect

auto Initially shows the minutes of the 
current time (i.e., at 45 at 11:45, 03 at 
4:03 etc.)

nochange The minutes cannot be changed.
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edit
edit length 30 text "The rain in Spain"

Includes an edit field in the message entry screen.

Property Effect

required Text must be entered in this field 
before message may be sent

text "Your Text Here" Edit field initially contains Your Text 
Here

length n Limits text entry to n characters 
maximum

required Requires some text to be entered in 
this field before the message may be 
sent.

nochange The text in this edit field cannot be 
changed.  Makes this edit field behave 
like a static item.
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editml
editml length 90 height 3 width 30 text "The rain in Spain"

Includes a multi-line edit field in the message entry screen.  Useful for allowing very long text entries.  The 
format of the message in the multi-line edit control does not affect the format of the message text. 

Property Effect

required Text must be entered in this field 
before message may be sent

text "Your Text Here" Edit field initially contains Your Text 
Here

length n Limits text entry to n characters

required Requires some text to be entered in 
this field before the message may be 
sent.

nochange The text in this edit field cannot be 
changed.  Makes this edit field work 
like a static item.

height Specifies how many lines high the 
edit field is.

width Limits how many characters may be 
entered on each line.
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Warranty and License 
Agreement

InfoRad® Watch-IT™ Warranty
InfoRad® Watch-IT™
InfoRad, Inc. warrants only that the diskette upon which the software is furnished shall be free from 
substantial defects in materials and workmanship under proper and normal use for a period of ninety (90) 
days from the date of delivery.

This warranty does not extend to any diskette which has been damaged as a result of accident or misuse; or 
as a result of service or modification by anyone other than InfoRad, Inc.

InfoRad, Inc. does not warrant that the software will meet your requirements or that the operation of the 
software will be error free. You assume full responsibility for the selection of the software, its installation, 
use, and results. In no event will Information Radio Technology Inc. be liable to you or any other person 
for any damages, including any consequential damages, expenses, lost profits, lost data, or other damages 
arising out the use or of the inability to use the software

No other warranties, either express or implied, are made with respect to this software, including, but not 
limited to, the implied warranties of merchantability and fitness for a particular purpose, and InfoRad, Inc. 
expressly disclaims all warranties not stated herein.

Some states do not allow the exclusion of implied warranties, so the above exclusion may not apply to you. 
This warranty gives you specific legal rights, and you may also have other rights which vary from state to 
state. Some states do not allow the limitation or exclusion of incidental or consequential damages for 
consumer products, so the above limitations or exclusions may not apply to you.

InfoRad,  Inc.
635 East 185th St.
Cleveland, OH 44119
PHONE (216) 531-1313

www.inforad.com
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License Agreement
InfoRad® Watch-IT™
Read this agreement carefully before using this package. Use of this package by you or your agent, 
including your employee, means that you accept the terms of this License Agreement. If you do not agree 
to the terms of this license agreement, discontinue use of the software now. A refund is issued only if you 
have removed all the associated software files related to this package from your computer system and have 
destroyed all backup copies before returning the software. Your money will be refunded if you have 
honored the above stated refund terms and the package is returned within 30 days of purchase. If a 
demonstration version has been supplied, it in addition to the terms stated in this agreement is not for sale 
or copy. The demonstration version is supplied solely for demonstrating the product’s features and ability 
to operate.

This License Agreement licenses the use of this product for the United States of America and in countries 
that adhere to the copyright laws of the United States of America. No use of this software product is 
authorized or granted by this agreement beyond the United States of America and  countries that adhere to 
the copyright laws of the United States of America.

THE LICENSEE IS ENTITLED TO:

1. Use one copy of the licensed program on a single machine unless this software has been purchased 
with a multi-user SITE or LAN license;

2. Remove the licensed program from one computer and install it on another. At no time is it permitted to 
make multiple copies for others to use or transfer the program license except under the terms set forth 
within this agreement; 

3. Make one copy of the software solely for backup purposes;

4. Transfer the program and license to another party so long as the other party agrees to the terms and 
conditions of this Agreement, and written notification is given to InfoRad, Inc. of said transfer. If the 
program is transferred, all copies not transferred, whether in machine readable or printed form must be 
destroyed. This includes all modifications and portions of the program used;

5. Use the manual for its intended purpose by the licensee or his agents.

6. Telephone Technical Support for 90 days for Registered users. Registration may be in the form of 
Auto-Registration, mail in registration form, fax in registration form, or telephone registration.

THE LICENSEE IS PROHIBITED FROM:

1. Using, modifying, copying or in any way transferring, by any means or medium the licensed program 
except as expressly permitted by this Agreement or by prior written agreement of  InfoRad, Inc.;

2. Distributing, renting, giving, lending, sub-licensing or leasing, disseminating, translating, reverse 
engineering, decompiling, disassembling and/or creating derivative works from the licensed program;

3. Using or allowing use of the backup copy unless the purchased diskette becomes defective;

4. Copying the manual or using the manual except as authorized.
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COPYRIGHT: 

The software is licensed to you for your use, the software is not sold to you. The software and
documentation is owned by InfoRad, Inc., and  is protected by the copyright laws of the United States and 
by international treaties. You must reproduce and include the copyright notice on any backup copy. Any 
copy of the software made by you will be the property of InfoRad, Inc. and is subject to the terms and 
conditions of this agreement.

This license agreement terminates with the licensed purchaser or user upon transfer of this program or for 
failure to comply with the terms of this Agreement. Upon termination, the licensee has no rights to use this 
program and must destroy all copies in his or her possession.

InfoRad, Inc.  retains all rights not expressly granted by this Licensee Agreement. This Agreement 
constitutes the complete and exclusive Agreement between the parties. InfoRad reserves the right to change 
the terms of this agreement with subsequent releases of the software.

InfoRad, Inc.
635 East 185th Street
Cleveland, OH 44119
(216) 531-1313

www.inforad.com





InfoRad Watch-IT Index    141

Index
A

Access Rights Settings 103
AFP Errors 117
Alarm Code Mapping 39, 80
Automated Messaging 63
Auto-Registration 138

B

Backing Up Directories 98

C

Check Interval 32
Code Mapping 39, 80
Communications Errors 110
Communications Port 41
Communications Setup 18
Connection
Internet 19–22
Create status files 32, 36, 75, 104
Custom Messages 81, 85–86

D

Delimiters 66
Dialing Options 111
Dialing Problems 122
Directory Backup and Restore 98
Directory Entries 97
Directory Listings 84–85
Directory Maintenance 84–85

E

Edit Controls 26
Edit Serial Code 43
Edit User button 57–59
Error Codes 106
Error Message Files 36
Error Screen 105, 108
Errors
AFP 117
Communications 110, 112
Local 106
Other 122
Remote 107
TAPI 112



142  Index InfoRad Watch-IT
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